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Overview
Welcome to the Advanced Machining User's Guide. This guide is intended for users who need to become 
quickly familiar with the Advanced Machining Version 5 product. 

This overview provides the following information:

●     Advanced Machining in a Nutshell

●     Before Reading this Guide

●     Getting the Most Out of this Guide

●     Accessing Sample Documents

●     Conventions Used in this Guide.

Advanced Machining in a Nutshell
Advanced Machining easily defines NC programs dedicated to machining complex 3D parts (aerospace, 
hydraulic, turbo-machinery, and so on) within a single workbench including 2.5 to 5-axis machining 
technologies. Complementary to other V5 Machining solutions, this product brings new functionalities in 
order to cover the entire machining process in addition to existing key functionalities that speed up skill 
oriented operations. All these functionalities overtake previous version CATIA Machining solutions, and 
therefore surpass existing all-in-one CAM systems.

Advanced Machining offers the following main functions: 

●     Accurate tool path definition through a full set of 2.5 to 5 axis milling and drilling machining capabilities

●     Quick tool path definition thanks to an intuitive user interface

●     Flexible management of tools and tool catalogs

●     Definition of machining areas including multi-thickness areas

●     Check and repair tool holder collisions

●     Quick verification of tool path

●     In-process part visualization and material removal simulation in multi-axis mode

●     Tool path editor

●     Fast tool path update after modification

●     Seamless NC data generation

●     Automatic shop-floor documentation

●     Management of NC related documents

●     Multi-CAD management

●     Integration with DELMIA

●     NC know-how capitalization and reuse

●     Productive design change management.

Before Reading this Guide



Before reading this guide, you should be familiar with basic Version 5 concepts such as document windows, 
standard and view toolbars. Therefore, we recommend that you read the Infrastructure User's Guide that 
describes generic capabilities common to all Version 5 products. It also describes the general layout of V5 
and the interoperability between workbenches.

You may also like to read the following complementary product guides, for which the appropriate license is 
required: 

●     NC Manufacturing Infrastructure User's Guide: explains how to use common Machining functionalities

●     Surface Machining User's Guide: describes 3-axis machining considerations

●     Multi-Axis Machining User's Guide: describes multi-axis machining considerations

●     Prismatic Machining User's Guide: describes 2.5-axis machining considerations

●     Prismatic Machining Preparation Assistant User's Guide: describes Machinable Features recognition and 
associated functionalities for preparing a Design Part for Prismatic Machining.

Getting the Most Out of this Guide
To get the most out of this guide, we suggest that you start reading and performing the step-by-step 
Getting Started tutorial. This tutorial will show you how to produce an NC program by using advanced 
machining techniques. 

Once you have finished, you should move on to the User Tasks section, which gives more complete 
information about the product's functionalities. The Reference section provides useful complementary 
information.

The Workbench Description section, which describes the commands that are specific to Advanced 
Machining, the Customizing section, which explains how to customize settings, and the Methodology 
section, which provides useful information about recommended work methods, will also certainly prove 
useful.

Accessing Sample Documents
To perform the scenarios, you will be using sample documents contained in the 
doc/online/amgug_C2/samples folder. For more information about this, refer to Accessing Sample 
Documents in the Infrastructure User's Guide.
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Conventions
Certain conventions are used in CATIA, ENOVIA & DELMIA documentation to help you recognize and 
understand important concepts and specifications. 

Graphic Conventions

The three categories of graphic conventions used are as follows:

●     Graphic conventions structuring the tasks

●     Graphic conventions indicating the configuration required

●     Graphic conventions used in the table of contents

Graphic Conventions Structuring the Tasks

Graphic conventions structuring the tasks are denoted as follows:

This icon... Identifies...

estimated time to accomplish a task

a target of a task

the prerequisites

the start of the scenario

a tip

a warning

information

basic concepts

methodology

reference information

information regarding settings, customization, etc.

the end of a task

functionalities that are new or enhanced with this release

allows you to switch back to the full-window viewing mode



Graphic Conventions Indicating the Configuration Required 

Graphic conventions indicating the configuration required are denoted as follows:

This icon... Indicates functions that are... 

specific to the P1 configuration

specific to the P2 configuration

specific to the P3 configuration

Graphic Conventions Used in the Table of Contents

Graphic conventions used in the table of contents are denoted as follows:

This icon... Gives access to...

Site Map

Split View mode

What's New?

Overview

Getting Started

Basic Tasks

User Tasks or the Advanced Tasks

Workbench Description

Customizing

Reference

Methodology

Glossary

Index

Text Conventions

The following text conventions are used:

●     The titles of CATIA, ENOVIA and DELMIA documents appear in this manner throughout the text.

●     File -> New identifies the commands to be used.



●     Enhancements are identified by a blue-colored background on the text.

How to Use the Mouse

The use of the mouse differs according to the type of action you need to perform.

Use this
mouse button... Whenever you read...

 
●     Select (menus, commands, geometry in graphics area, ...)

●     Click (icons, dialog box buttons, tabs, selection of a location in the document 
window, ...)

●     Double-click

●     Shift-click

●     Ctrl-click

●     Check (check boxes)

●     Drag

●     Drag and drop (icons onto objects, objects onto objects)

●     Drag

●     Move

●     Right-click (to select contextual menu)



What's New?

Enhanced Functionalities

Interpolation mode for Multi-Axis Helix Machining
Generates a single helix tool path to mill a blisk blade, while avoiding collisions with neighboring 
blades.

The Multi-Pockets Machining operation is renamed Cavities Roughing
Modifications to Insert menu and Machining Operations toolbar.

Enhancements brought to multi-axis machining operations

Please refer to the Multi-Axis Surface Machining User's Guide for more information.

Enhancements brought to 3-axis machining operations

Please refer to the 3-Axis Surface Machining User's Guide for more information.

Enhancements brought to 2.5-axis machining operations

Please refer to the Prismatic Machining User's Guide for more information.

Enhancements brought to the NC Manufacturing Infrastructure

This product benefits from enhancements to the infrastructure's general functions (NC resources, program 
management, geometry management, replay and simulation, NC data output, PLM integration, and so on).

Please refer to the NC Manufacturing Infrastructure User's Guide for more information.
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Getting Started
Before getting into the detailed instructions for using Advanced Machining, this tutorial is intended to give 
you a feel of what you can accomplish with the product.  

It provides the following step-by-step scenario that shows you how to use some of the key functionalities. 

Enter the Workbench and Setup the Part Operation
Create a Roughing Operation

Create an Isoparametric Machining Operation
Create a Multi-Axis Flank Contouring Operation

Generate NC Code



Enter the Workbench and Setup the Part Operation

This first task shows you how to open the part to machine, enter the Advanced Machining workbench, and setup the 
Part Operation.

1. Select File > Open then select the SampleProductAMG.CATProduct document.

2. Select Machining > Advanced Machining from the Start menu. The Advanced Machining workbench appears. The 
part is displayed in the Setup Editor window along with the manufacturing specification tree. 

 

 3. Double click Part Operation.1 in the tree. The Part Operation dialog box appears.

 

4. Select the Machine icon  to access the Machine Editor dialog box. 

●     Select the 5-axis Machine icon.

●     In the Compensation tab, set the options as follows:

In this case a Compensation tab will appear in the Strategy page of the editor of all machining operations 
that support cutter compensation.

●     Click OK to return to the Part Operation dialog box.

 5. Select the Stock icon  then select the stock geometry. 
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 6. Click OK to accept the Part Operation.

7. Select  Manufacturing Program.1 in the tree to make it the current entity.

To insert program entities such as machining operations, tools and auxiliary commands you can either: 
●     make the program current before clicking the insert program entity command

●     click the insert program entity command then make the program current.



Create a Roughing Operation

This task shows you how to insert a Roughing operation into the program. This operation rough machines parts by horizontal 
planes, so you must define: 

●     geometry

●     machining strategy parameters

●     tool.

Make the Manufacturing Program the current entity in the tree.

1. Select the Roughing icon . 

A Roughing entity and a default tool are added to the program.

The dialog box opens at the Geometry tab page .

This page includes a sensitive icon to help you specify the geometry to be machined.

2. Click the red Part area in the sensitive icon and select the part body in the viewer.

Double click anywhere in the viewer to confirm your selection and display the dialog box again.

3. Click the Rough stock area in the sensitive icon and select the stock in the viewer.

Please note that you may need to use the Hide/Show command to make the Stock visible.

Double click anywhere in the viewer to confirm your selection and display the dialog box again.

4. Select the Strategy tab page  to specify: 

●     Machining parameters:



●     Radial parameters:

●     Axial parameters:

5. Select the Tool tab page .

6. Enter a  name of the new tool (for example, T1 End Mill D 32 RC4). 



7. Double click the D (nominal diameter) parameter in the icon, then enter 32mm in the Edit Parameter dialog box.

The tool icon is updated to take the new value into account.

Set the db (body diameter) parameter to 32mm in the same way.

8. If needed, deselect the Ball-end tool checkbox. 

Double click the Rc (corner radius) parameter in the icon, then enter 4mm in the Edit Parameter dialog box. 

9. Click Replay to compute the operation and visualize the tool path. You will see that the part has been rough machined. 



10. Click OK to create the operation.



Create an Isoparametric Machining Operation

This task illustrates how to create an Isoparametric Machining operation in the program.

1. Select the Isoparametric Machining icon . 

An Isoparametric Machining entity is added to the program. It is initialized with the tool used in the previous operation.

The Isoparametric Machining dialog box appears directly at the Geometry tab page .  

This tab page includes a sensitive icon to help you specify the geometry to be machined. 

The part surface and corner points of the icon are colored red indicating that this geometry is required. All other geometry is 
optional. 

2. Click the red part surface in the icon then select the desired surfaces in the 3D window.

3. Click a red point in the icon then select the four corner points of the part surface.

The part surface and corner points of the icon are now colored green indicating that this geometry is now defined.



4. Select the Strategy tab page  to specify: 

●     Machining parameters:

●     Radial parameters: Set Number of paths to 3.

●     Tool Axis parameter: Set Guidance to Fixed axis.

●     Compensation: Set Compensation output to No.

5. Click Replay to compute the operation and visualize the tool path.  

6. Click OK to create the operation.



Create a Multi-Axis Flank Contouring Operation

This task illustrates how to create a Multi-Axis Flank Contouring operation in the program. 

1. Select the Multi-Axis Flank Contouring icon . 

A Multi-Axis Flank Contouring entity along is added to the program. It is initialized with the tool used in the previous 
operation.

The Multi-Axis Flank Contouring dialog box appears directly at the Geometry tab page .  

2. Click the red part surface in the icon then select the desired part surface in the 3D window.

3. Click the red drive surface in the icon then select the desired drives in the 3D window.

4. Click the start and stop elements in the icon then select the desired elements in the 3D window.

5. Select the Strategy tab page  to specify: 

●     Machining parameters:



●     Tool Axis parameters: 

●     Stepover parameters:

●     In the Finishing tab, request a Side finish pass on last level with a 1mm Side finish thickness. 

●     In the Compensation tab, select 3D Radial compensation output
Please note that the generated APT source will contain information for cutter radius compensation. Output is the tool tip 
point (XT, YT, ZT), tool axis vector (IJK) and the drive surface normal (PQR).

●     High speed milling is not required in this scenario.

6. Select the Tool tab page  to create a new tool.  Enter a name for the tool (for example, T1 End Mill D 16 RC4) and 

the following characteristics:



7. Click Replay to compute the operation and visualize the tool path.  



8. Click OK to create the operation. The specification tree is updated as follows.



Generate NC Data

This task shows you how to generate NC data in APT format from the program. 

For more information about this procedure please refer to Program Output.

1. Use the right mouse key on the Manufacturing Program.1 entity in the tree to select 
Manufacturing Program.1 object > Generate NC Code Interactively. The Generate NC Output 
Interactively dialog box appears. 
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 2. Select APT as the desired NC data type.

3. Click the Output File [...] button to select the folder where you want the file to be saved and 
specify the name of the file.

4. Click Execute to generate the APT source file.

An extract from a typical APT source file is given below.

Please note that the Flank Contouring portion of this source contains information for cutter 
radius compensation. Output is the tool tip point (XT, YT, ZT), tool axis vector (IJK) and the 
drive surface normal (PQR).

$$ -----------------------------------------------------------------
$$ Generated on Thursday, October 16, 2003 09:52:12 AM
$$ CATIA APT VERSION 1.0
$$ -----------------------------------------------------------------
$$ Manufacturing Program.1
$$ Part Operation.1
$$*CATIA0
$$ Manufacturing Program.1
$$ 1.00000 0.00000 0.00000 0.00000
$$ 0.00000 1.00000 0.00000 0.00000
$$ 0.00000 0.00000 1.00000 0.00000
PARTNO PART TO BE MACHINED
COOLNT/ON
CUTCOM/OFF
$$ OPERATION NAME : Tool Change.1
$$ Start generation of : Tool Change.1
MULTAX
$$ TOOLCHANGEBEGINNING
RAPID
GOTO / 0.00000, 0.00000, 100.00000, 0.000000, 0.000000, 1.000000
CUTTER/ 32.000000, 4.000000, 12.000000, 4.000000, 0.000000,$
0.000000, 50.000000
TOOLNO/3, 32.000000
TPRINT/T1 End Mill D 32 RC4
LOADTL/3
$$ End of generation of : Tool Change.1
$$ OPERATION NAME : Roughing.1
$$ Start generation of : Roughing.1
SPINDL/ 70.0000,RPM,CLW
RAPID
GOTO / 49.14075, -129.01000, 50.20000, 0.000000, 0.000000, 1.000000
RAPID
GOTO / 49.14075, -129.01000, 50.00000, 0.000000, 0.000000, 1.000000
FEDRAT/ 300.0000,MMPM
GOTO / 49.14075, -129.01000, 40.00000, 0.000000, 0.000000, 1.000000
.
.
.
GOTO / -22.69277, -110.01000, -0.00000, 0.000000, 0.000000, 1.000000
FEDRAT/ 1000.0000,MMPM
GOTO / -22.69277, -110.01000, 10.00000, 0.000000, 0.000000, 1.000000
RAPID
GOTO / -22.69277, -110.01000, 50.20000, 0.000000, 0.000000, 1.000000
$$ End of generation of : Roughing.1
$$ OPERATION NAME : Isoparametric Machining.1
$$ Start generation of : Isoparametric Machining.1
FEDRAT/ 1000.0000,MMPM
SPINDL/ 70.0000,RPM,CLW
GOTO / 94.69478, -9.32685, 6.00000, 0.000000, 0.000000, 1.000000



GOTO / 86.33038, -9.32685, 6.00000, 0.000000, 0.000000, 1.000000
.
.
.
GOTO / 91.86793, -4.77816, 7.49749, 0.000000, 0.000000, 1.000000
GOTO / 2.80778, -4.79095, 35.40089, 0.000000, 0.000000, 1.000000
$$ End of generation of : Isoparametric Machining.1
$$ OPERATION NAME : Tool Change.2
$$ Start generation of : Tool Change.2
$$ TOOLCHANGEBEGINNING
RAPID
GOTO / 0.00000, 0.00000, 100.00000, 0.000000, 0.000000, 1.000000
CUTTER/ 16.000000, 4.000000, 4.000000, 4.000000, 0.000000,$
0.000000, 50.000000
TOOLNO/4, 16.000000
TPRINT/T1 End Mill D 16 RC4
LOADTL/4
$$ End of generation of : Tool Change.2
$$ OPERATION NAME : Multi-Axis Flank Contouring.1
$$ Start generation of : Multi-Axis Flank Contouring.1
LOADTL/4,1
FEDRAT/ 1000.0000,MMPM
SPINDL/ 70.0000,RPM,CLW
CUTCOM/ SAME, NORMDS
CUTCOM/ NORMDS
$$ START CUTCOM NORMDS XT,YT,ZT,I,J,K,P,Q,R
GOTO / 100.00276, -17.79095, 34.00000, 0.000000, 0.000000, 1.00000$
0, 0.000000,-1.000000, 0.000000
GOTO / -17.69092, -17.79095, 34.00000, 0.000000, 0.000000, 1.00000$
0, 0.000000,-1.000000, 0.000000
.
.
.
GOTO / 117.59356, -82.66197, 4.36385,-0.000004,-0.087155, 0.99619$
5,-0.012004, 0.996123, 0.087149
GOTO / 142.86522, -82.35744, 4.36385,-0.000004,-0.087155, 0.99619$
5,-0.022595, 0.995940, 0.087133
CUTCOM/OFF
$$ END CUTCOM NORMDS XT,YT,ZT,I,J,K,P,Q,R
$$ End of generation of : Multi-Axis Flank Contouring.1
SPINDL/OFF
REWIND/0
END



User Tasks
The user tasks you will perform in the Advanced Machining workbench involve creating, editing and 
managing machining operations and other machining entities.

Drilling Operations
2.5-axis Milling Operations
3-axis Milling Operations

Multi-Axis Milling Operations
Auxiliary Operations

Part Operations, Manufacturing Programs and Machining Processes
NC Manufacturing Entities

Verification, Simulation and Program Output
Tool Path Editor



Drilling Operations
The tasks for creating 2.5 to 5-axis drilling operations are documented in the Prismatic Machining User's 
Guide.

Spot Drilling Operation

 
Create a Spot Drilling Operation: Select the Spot Drilling icon then select the hole or hole 
pattern to be machined and specify the tool to be used. Specify machining strategy parameters, 
macros and feeds and speeds as needed.

Drilling Operations

 
Create a Drilling Operation: Select the Drilling icon then select the hole or hole pattern to be 
machined and specify the tool to be used. Specify machining strategy parameters, macros and 
feeds and speeds as needed.

 
Create a Drilling Dwell Delay Operation: Select the Drilling Dwell Delay icon then select the hole 
or hole pattern to be machined and specify the tool to be used. Specify machining strategy 
parameters, macros and feeds and speeds as needed.

 
Create a Drilling Deep Hole Operation: Select the Drilling Deep Hole icon then select the hole or 
hole pattern to be machined and specify the tool to be used. Specify machining strategy 
parameters, macros and feeds and speeds as needed.

 
Create a Drilling Break Chips Operation: Select the Drilling Break Chips icon then select the hole 
or hole pattern to be machined and specify the tool to be used. Specify machining strategy 
parameters, macros and feeds and speeds as needed.

Hole Finishing Operations

 
Create a Reaming Operation: Select the Reaming icon then select the hole or hole pattern to be 
machined and specify the tool to be used. Specify machining strategy parameters, macros and 
feeds and speeds as needed.

 
Create a Counterboring Operation: Select the Counterboring icon then select the hole or hole 
pattern to be machined and specify the tool to be used. Specify machining strategy parameters, 
macros and feeds and speeds as needed.

Boring Operations

 
Create a Boring Operation: Select the Boring icon then select the hole or hole pattern to be 
machined and specify the tool to be used. Specify machining strategy parameters, macros and 
feeds and speeds as needed.

 
Create a Boring Spindle Stop Operation: Select the Boring Spindle Stop icon then select the 
hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy 
parameters, macros and feeds and speeds as needed.

 
Create a Boring and Chamfering Operation: Select the Boring and Chamfering icon then select 
the hole or hole pattern to be machined and specify the tool to be used. Specify machining 
strategy parameters, macros and feeds and speeds as needed.
Create a Back Boring Operation: Select the Back Boring icon then select the hole or hole 
pattern to be machined and specify the tool to be used. Specify machining strategy parameters, 
macros and feeds and speeds as needed.

Threading Operations
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Create a Tapping Operation: Select the Tapping icon then select the hole or hole pattern to be 
machined and specify the tool to be used. Specify machining strategy parameters, macros and 
feeds and speeds as needed.

 
Create a Reverse Threading Operation: Select the Reverse Threading icon then select the hole 
or hole pattern to be machined and specify the tool to be used. Specify machining strategy 
parameters, macros and feeds and speeds as needed.

 
Create a Thread without Tap Head Operation: Select the Thread without Tap Head icon then 
select the hole or hole pattern to be machined and specify the tool to be used. Specify 
machining strategy parameters, macros and feeds and speeds as needed.
Create a Thread Milling Operation: Select the Thread Milling icon then select the hole or hole 
pattern to be machined and specify the tool to be used. Specify machining strategy parameters, 
macros and feeds and speeds as needed.

Countersinking and Chamfering Operations

 
Create a Countersinking Operation: Select the Countersinking icon then select the hole or hole 
pattern to be machined and specify the tool to be used. Specify machining strategy parameters, 
macros and feeds and speeds as needed.
Create a Chamfering Two Sides Operation: Select the Chamfering Two Sides icon then select 
the hole or hole pattern to be machined and specify the tool to be used. Specify machining 
strategy parameters, macros and feeds and speeds as needed.

T-Slotting and Circular Milling
Create a T-Slotting Operation: Select the T-Slotting icon then select the hole or hole pattern to 
be machined and specify the tool to be used. Specify machining strategy parameters, macros 
and feeds and speeds as needed.
Create a Circular Milling Operation: Select the Circular Milling icon then select the hole or hole 
pattern to be machined and specify the tool to be used. Specify machining strategy parameters, 
macros, and feeds and speeds as needed.
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2.5-axis Milling Operations
The tasks for creating 2.5-axis milling operations are documented in the Prismatic Machining User's Guide.

Pocketing Operations
Select the Pocketing icon then select the geometry to be machined (open or closed pocket, islands, 
and so on). Specify the tool to be used. 
Set parameters for axial and radial machining and other criteria such as finishing and high-speed 
milling. Set feeds and speeds and NC macros as needed. 

A Pocketing operation can be created for machining: 

●     Closed pockets
Tool machines the area delimited by hard boundaries

●     Open pockets
Tool machines the area that has a least one soft boundary.

Facing Operations
Create a Facing Operation:  Select the Facing icon then select the geometry to be machined and 
specify the tool to be used. 
Set parameters for axial and radial machining and other criteria such as finishing and high-speed 
milling. Set feeds and speeds and NC macros as needed.

Profile Contouring Operations
Select the Profile Contouring icon then select the geometry to be machined and specify the tool to 
be used. 
Set parameters for axial and radial machining and other criteria such as finishing. Set feeds and 
speeds and NC macros as needed. 

A Profile Contouring operation can be created for machining: 

●     Between two planes
Tool follows contour between top and bottom planes while respecting user-defined geometry 
limitations and machining strategy parameters.

●     Between two curves
Tool follows trajectory defined by top and bottom guide curves while respecting user-defined 
geometry limitations and machining strategy parameters.

●     Between a curve and surfaces 
Tool follows trajectory defined by a top guide curve and bottom surfaces while respecting user-
defined geometry limitations and machining strategy parameters.

●     By flank contouring 
Tool flank machines vertical part surface while respecting user-defined geometry limitations and 
machining strategy parameters.
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Groove Milling Operations
Create a Groove Milling Operation: Select the Groove Milling icon then select the geometry to be 
machined and specify the tool to be used. Specify machining parameters and feeds and speeds as 
needed.

Point to Point Operations
Create a Point to Point Operation: Select the Point to Point icon then define a sequence of 
elementary Goto Point, Goto Position, and Go Delta motions. Specify the tool to be used, machining 
parameters, NC macros, and feeds and speeds as needed.

Curve Following Operations
Create a Curve Following Operation: Select the Curve Following icon then select the geometry to be 
machined and specify the tool to be used. Specify machining parameters, NC macros, and feeds 
and speeds as needed.

Operations for Reworking Corners and Channels
Corners and channels left unmachined by Pocketing or Profile Contouring operations can be 
identified thanks to a Prismatic Rework Area feature. This feature can then be used to Create 
operations for reworking corners and channels.
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3-axis Milling Operations

Cavities Roughing

Cavities Roughing proposes a process-focused solution to machine Cavity Parts dedicated to Mechanical and 
Aerospace industries: 

●     Rough to finish pockets of machined part with only one tool and one tool path

●     Roughing with over-thickness, finishing sides and bottom with waterline machining

●     Rough to finish with several tools using rework technology

●     Dedicated operation to finish top of stiffeners.

Create a Cavities Roughing operation: Select the Cavities Roughing icon, choose the area to machine 
and specify the tool to be used. You can also specify machining parameters, feedrates and spindle 
speeds.

The tasks for creating the following 3-axis milling operations are documented in the 3-Axis Surface 
Machining User's Guide.

Rough Machining the Part
Create a Sweep Roughing operation: Select the Sweep Roughing icon, choose the part to machine and 
specify the tool to be used. You can also specify machining parameters, feedrates and spindle speeds.
Create a Roughing operation: Select the Roughing icon, choose the part to machine and specify the 
tool to be used. You can also specify machining parameters, feedrates and spindle speeds.

Semi-Finish the Part
Create a Sweeping operation: Select the Sweeping icon, choose the part to machine and specify the 
tool to be used. You can also specify machining parameters, feedrates and spindle speeds.
Create a ZLevel machining operation: Select the Z-Level icon, choose the part to machine and specify 
the tool to be used. You can also specify machining parameters, feedrates and spindle speeds.
Create a Contour-driven machining operation: Select the Contour Driven icon, choose the part to 
machine and specify the tool to be used. You can also specify machining parameters, feedrates and 
spindle speeds.
Create a Spiral Milling operation: Select the Spiral Milling icon, choose the part to machine and specify 
the tool to be used. You can also specify machining parameters, feedrates and spindle speeds.
Create a Isoparametric machining operation: Select the Isoparametric Machining icon, choose the part 
to machine and specify the tool to be used. You can also specify machining parameters, feedrates and 
spindle speeds.

Rework Areas of the Part

You can use the following operation to rework an area on a part where there is residual material. Before 
using this operation, compute the areas that you want to rework.

Create a Pencil operation: Select the Pencil icon, choose the area to rework and specify the tool to be 
used. You can also specify machining parameters, feedrates and spindle speeds.
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Cavities Roughing
This task shows you how to machine the center of a part.

1.  Open the MultiPockets1.CATPart from the samples directory.

2.  Create the rough stock:

●     select the Creates rough stock icon

●     pick the part

●     select PartBody as the Destination.

3.  Select the Cavities Roughing icon  and select Machining Program.1 in the specification tree.
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The Power machining dialog box is open. 

4.  Select the Rough stock and the part to machine.



5.  Go to the Machining tab and make sure the Machining strategy is set to Center(1) only.



6.  Press the Tool path replay button.

Now we are going to optimize the tool path:

7.  In the Geometry tab, place the cursor on the machining direction arrow and select Optimize from its contextual 

menu.

Push the Tool Path Replay button.



You can see that the tool path direction has been adapted to the geometry to machine, i.e. defined by the shape of 

each pocket and set along the main direction (X or Y).

In the Machining tab, in the Center parameters, go to the HSM tab and make sure the High Speed Milling option 

is selected.

Push the Tool Path Replay button. You can note that the corners are rounded.





Multi-Axis Machining Operations
The tasks in this section show you how to create multi-axis operations in your manufacturing program.

Multi-Axis Flank Contouring operation
Select the Multi-Axis Flank Contouring icon then select the geometry to be machined. Specify the tool 
to be used. Set the Guiding strategy and choose one of the following Tool axis modes: 

●     Tanto Fan

●     Combin Tanto

●     Combin Parelm

●     Mixed Combin

●     Fixed

●     Normal to Part.

Note that the tool axis strategy can be automatically adjusted to avoid collisions in certain cases by 
selecting an auxiliary guide curve.

Specify machining parameters, feeds and speeds, and NC macros as needed. 

The following user tasks illustrate some of this operation's capabilities:

●     Tanto Fan tool axis mode

●     Combin Tanto tool axis mode

●     Local modifications 

●     Non-contiguous drives.

Multi-Axis Helix Machining operation
Select the Multi-Axis Helix Machining icon then select the geometry to be machined. Specify the tool to 
be used. Set the Guiding strategy and choose one of the following Tool axis modes: 

●     Lead and Tilt

●     4-Axis Tilt

●     Intrrpolation.

Specify machining parameters, feeds and speeds, and NC macros as needed. 

User tasks illustrate the following Tool axis modes for this operation: 

●     Lead and Tilt 

●     Interpolation.



The tasks for creating other multi-axis milling operations are documented in the Multi-Axis Surface 
Machining User's Guide.

Multi-Axis Sweeping operation
Select the Multi-Axis Sweeping icon then select the geometry to be machined.  You can use Offset 
Groups and Features when defining geometry. Specify the tool to be used. Set the Tool axis mode then 
specify machining parameters, feeds and speeds, and NC macros as needed. 

User tasks illustrate the following Tool axis modes for this operation: 

●     Lead and Tilt 

●     Fixed

●     Thru a Point

●     Normal to Line

●     4-Axis Lead/Lag

●     Optimized Lead.

Multi-Axis Contour Driven operation
Select the Multi-Axis Contour Driven icon then select the geometry  to be machined. You can use 
Offset Groups and Features when defining geometry. Specify the tool to be used. Set the Guiding 
strategy and choose one of the following Tool axis modes: 

●     Lead and Tilt

●     Fixed

●     Thru a Point

●     Normal to Line

●     4-Axis Lead/Lag

●     Optimized Lead.

Specify machining parameters, feeds and speeds, and NC macros as needed.

User tasks illustrate the following Guiding strategies for this operation: 

●     Between contours

●     Parallel contours

●     Spine contour.

Multi-Axis Curve Machining operation
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Select the Multi-Axis Curve Machining icon then select the geometry to be machined. Specify the tool 
to be used. Set the Machining mode and choose one of the following Tool axis modes: 

●     Lead and Tilt

●     Fixed

●     Interpolation

●     Thru a Point

●     Normal to Line

●     Optimized Lead (for Contact machining only)

●     Tangent Axis (for Between Two Curves and Between Curve and Part modes only)

●     4-axis Lead/Lag.

Specify machining parameters, feeds and speeds, and NC macros as needed.

User tasks illustrate the following Machining modes for this operation: 

●     Contact

●     Between two curves with Tip or Side machining 

●     Between a curve and part with Tip or Side machining.

Multi-Axis Isoparametric Machining operation
Select the Isoparametric Machining icon then select the geometry to be machined. Specify the tool to 
be used. Set the Machining mode and choose one of the following Tool axis modes: 

●     Lead and Tilt

●     Fixed

●     Interpolation

●     Thru a Point

●     Normal to Line

●     Optimized Lead

●     4-Axis Lead/Lag

●     4-Axis Tilt.

Specify machining parameters, feeds and speeds, and NC macros as needed.

User tasks illustrate the following Tool Axis modes for this operation: 

●     Lead and Tilt

●     4-Axis Lead

●     Interpolation.
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Create a Multi-Axis Flank Contouring Operation in 
Tanto Fan Mode

This task illustrates how to create a Multi-Axis Flank Contouring operation in the program. The tool 
axis will be guided in Tanto Fan mode.

To create the operation you must define: 

●     the geometry to be machined 

●     the tool that will be used 

●     the parameters of the machining strategy 

●     the feedrates and spindle speeds 

●     the macros (transition paths) .

Open the Flank_5X_test_part.CATPart document, then select Machining > Advanced Machining from 
the Start menu. Make the Manufacturing Program current in the specification tree.  

1. Select the Multi-Axis Flank 

Contouring icon . 

A Multi-Axis Flank 
Contouring entity along with 
a default tool is added to the 
program.

The Multi-Axis Flank 
Contouring dialog box 
appears directly at the 

Geometry tab page .  

The part, drive and 
start/stop elements of the 
sensitive icon are colored 
red indicating that this 
geometry is required.

2. Click the red part surface in the icon then select the desired surfaces in the 3D window.

3. Click the red drive surface in the icon then select the desired drives in the 3D window (Drives 1 to 
5).

4. Click the start and stop elements in the icon then select the desired limiting elements in the 3D 
window.
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After geometry selection, the surfaces of the icon are colored green indicating that this geometry 
is now defined.

5. Select the Strategy tab page  to specify: 

Machining parameters:

Stepover parameters:



Tool axis guidance parameters:

In this example, Finishing, High-speed milling and Compensation are not required.

6. Click Preview in the dialog box to verify the parameters that you have specified. 

A message box appears giving feedback about this verification. 

7. Select the Tool tab page  and specify a 16mm ball end mill.  

For more information please refer to Edit the Tool of an Operation.

8. If needed, select the Feeds and Speeds tab page  to specify feedrates and spindle speeds 

for the operation. Otherwise default values are used.

9. If needed, select the Macros tab page  to specify the operation's transition paths (approach 

and retract motion, for example). See Define Macros of an Operation for an example of specifying 
transition paths on a multi-axis machining operation. 
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10. Before accepting the operation, you should check its validity by replaying the tool path. 

11. Click OK to create the operation.
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 Create a Multi-Axis Flank Contouring Operation in 
Combin Tanto Mode

This task illustrates how to create a Multi-Axis Flank Contouring operation in the program. The tool axis 
will be guided in Combin Tanto mode.

To create the operation you must define: 

●     the geometry to be machined 

●     the tool that will be used 

●     the parameters of the machining strategy 

●     the feedrates and spindle speeds 

●     the macros (transition paths) .

Open the Flank_5X_test_part.CATPart document, then select Machining > Advanced Machining from the 
Start menu. Make the Manufacturing Program current in the specification tree.  

1. Select the Multi-Axis Flank 

Contouring icon . 

A Multi-Axis Flank Contouring 
entity along with a default tool is 
added to the program.

The Multi-Axis Flank Contouring 
dialog box appears directly at the 

Geometry tab page .  

The part, drive and start/stop 
elements of the sensitive icon are 
colored red indicating that this 
geometry is required. All other 
geometry is optional. 

2. Click the red part surface in the icon then select the desired surface in the 3D window.

3. Click the red drive surface in the icon then select the desired drive in the 3D window (Drive 1).

4. Click the start and stop elements in the icon then select the desired limiting elements in the 3D 
window.
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After geometry selection, the surfaces of the icon are colored green indicating that this geometry is 
now defined.

5. Select the Strategy tab page  to specify: 

Machining parameters:

Stepover parameters:



Tool axis guidance parameters:

In this example, Finishing, High-speed milling and Compensation are not required.

6. Click Preview in the dialog box to verify the parameters that you have specified. 

A message box appears giving feedback about this verification. 

A tool is proposed by default when you want to create a machining operation. If the proposed tool is 

not suitable, just select the Tool tab page  to specify the tool you want to use.  

Please refer to Edit the Tool of an Operation.

7. Select the Feeds and Speeds tab page  to specify the feedrates and spindle speeds for the 

operation.

8. Select the Macros tab page  to specify the operation's transition paths (approach and retract 

motion, for example).  

See Define Macros of an Operation for an example of specifying transition paths on a multi-axis 
machining operation. 
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Before accepting the operation, you should check its validity by replaying the tool path. 

9. Click OK to create the operation.
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 Local Modifications to a 
Multi-Axis Flank Contouring Operation

This task illustrates how to create then locally modify a Multi-Axis Flank Contouring operation in the program. First the operation 
will be globally created in Tanto Fan mode. Then the first and last drives will be locally modified to:

●     use a different guiding strategy

●     use different offsets

●     use a 4-axis constraint.

Open the Part5XDemoGFC.CATPart document, then select Machining > Advanced Machining from the Start menu. Make the 
Manufacturing Program current in the specification tree.  

1.
Select the Multi-Axis Flank Contouring icon .

2. Use the sensitive icon in the Geometry page  to:

●     select the part surface

●     select the drive surfaces (Drive 1 to Drive 5) either 
manually or using the navigation functionality for face 
selection.

●     select the start and stop limiting elements

●     set a 1mm offset of the drive surfaces.

3. Select the Strategy tab page  to specify Tanto Fan tool axis guidance. 

The other Strategy parameters can be left at the default values. The default Tool, Feeds and Speeds, and NC macros can 
also be used.

4. Check the validity of the operation by replaying the tool path.
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5. Right click the drive surfaces area in the sensitive icon of the Geometry page and select Local Modifications. The Local 

Drive Surfaces dialog box appears: 

6. Double click line 1, which corresponds to the first drive. The Local Drive Surface 1 dialog box appears: 

Modify the drive by adding a 2mm offset and changing the tool axis guidance to Tanto. 



Click OK. The updated Local Drives dialog box appears:

7. Double click line 5, which corresponds to the last drive, and modify it in the same way.

8. Check the validity of the modifications by replaying the tool path. Tanto replaces Tanto Fan on first and last drives.

  
9. Click the 4X constraint symbol on the Strategy tab page  icon and select an edge as shown: 
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10. In the Local Drive 1 and Local Drive 5 dialog boxes, select the Enable 4-axis checkbox.  

The Local Drives dialog box is updated:

11. Check the validity of the modifications by replaying the tool path. The 4-axis constraint is applied on first and last drives.

 
12. Click OK to create the operation.

Please note: 
●     Tanto tool axis guidance only exists as a local mode.

●     4-axis constraint can only be applied to Normal to part and Tanto tool axis guidance.
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Multi-Axis Flank Contouring with Non Contiguous 
Drives on Different Solids

This task illustrates how to create a Multi-Axis Flank Contouring operation when the drive surfaces 
are non contiguous.  In this scenario, you will use:

●     drive surfaces located on two different solids

●     drive surface defined by additional geometry used to bridge a gap.

Open the AMG2Solids.CATProduct document, then select Machining > Advanced Machining from the 
Start menu. Make the Manufacturing Program current in the specification tree.  

1. Select the Multi-Axis Flank Contouring icon .

2. Use the sensitive icon in the Geometry page  to:

●     select the part surface (underside of gray solid, for example)

●     select the start and stop limiting elements

●     select Drive 1 on the flank of the blue solid and Drives 2 and 3 on the flanks of the gray 
solid. 

Drives 1 and 2 are non contiguous: they belong to different solids. 
Stopping and Restarting conditions must be defined on non contiguous drives.
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Arrows appear on Drives 1 and 2 indicating the orientation for each contiguous section. Make 
sure that they are oriented outward.  

Arrows appear whenever necessary to indicate the orientation for your drive selection. You 
must make sure that they are correctly oriented. 

3. Right click the drive surfaces area in the sensitive icon of the Geometry page and select Local 
Modifications. The Local Drive Surfaces dialog box appears. 

4. Double click line 1, which corresponds to the first drive. The Local Drive Surface 1 dialog box 
appears. Set the Stopping condition to To. 

Access the Local Drive Surface 2 dialog box using the '>>' button and set Restarting 
direction to Left.

5. The Local Drive Surfaces dialog box is updated as follows: 

 

Check the validity of the operation by replaying the tool path.  
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6. Change the position of the Stop element, then select Drives 4, 5 and 6.   

These Drives are non contiguous: Drive 5 is in fact geometry added by the user to close the gap 
between Drives 5 and 6.

7. Access the Local Drive Surface 4 dialog box and set Stopping condition to Tangent DS.
Access the Local Drive Surface 5 dialog box and set Stopping condition to Tangent DS.

Check the validity of the operation by replaying the tool path. 
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8. Change the position of the Stop element, then select  Drives 7 to 13 on the flanks of the gray 
solid. Select the last Drive 14 on the flank of the blue solid. 

Drives 13 and 14 are non contiguous: they belong to different solids.

An arrow appears on Drive 6 indicating the orientation for the contiguous section. Make sure 
that it is oriented outward. 

 9. Access the Local Drive Surface 13 dialog box and set Stopping condition to To. 
Access the Local Drive Surface 14 dialog box and set Restarting direction to Left.

  



 Check the validity of the operation by replaying the tool path. 

10. Click OK to create the operation.

Right clicking in the Local Drive Surfaces dialog box gives access to a number of contextual 
commands:  

●     Column Order and Column Filter for managing the columns of information that are shown

●     Properties for accessing the dialog box of the selected local drive

●     Reset to reset local drive selection in the list

●     Copy, Cut and Paste for managing the list of local drives.
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 Create a Multi-Axis Helix Machining Operation in 
Lead and Tilt Mode

This task illustrates how to insert a Multi-Axis Helix Machining operation in the program. This 
operation will be used to generate a single helix toolpath to mill an entire turbo-machinery blade. To 
create the operation you must define: 

●     the geometry to be machined 

●     the tool that will be used 

●     the parameters of the machining strategy  with the tool axis guided in Lead and Tilt 

mode

●     the feedrates and spindle speeds 

●     the macros (transition paths) .

Open the Blade.CATPart document, then select Machining > Advanced Machining from the Start 
menu. Make the Manufacturing Program current in the specification tree.  

1. Select the Multi-Axis Helix Machining icon . A Helix Machining entity along with a default 

tool is added to the program. The Multi-Axis Helix Machining dialog box appears directly at the 

Geometry tab page . 

The part surface, upper and lower contours, and leading and trailing edges of the sensitive icon 
are colored red indicating that this geometry is required and must be selected. The upper and 
lower contours and the leading and trailing edges must lie on the faces selected as part 
surface.
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Fixture geometry is optional. 

2. Click the red part surface in the icon then select the faces to be machined in the 3D window. In 
this scenario, you must select 4 faces: the front face, the back face and the two side faces.

The Face Selection toolbar appears to help you select faces or belts of faces.

Note that faces must be continuous. Gaps between faces may result in a bad tool path.

3. Select the upper and lower contours. The Edge Selection toolbar appears to help you select 
these contours. They must be closed contours

4. Select the leading and trailing edges to define the limits of the machining. The Edge Selection 
toolbar appears to help you select these edges. They must intersect the upper and lower 
contours.

  

The geometry entities of the icon are now colored green indicating that this geometry is now 
defined.



5. Select the Strategy tab page , then select a Start or Stop point using the sensitive icon.

Specify parameters for: 

●     Tool axis mode:

●     Machining:

●     Radial:



 A default reference tool axis (A) is displayed. You can double click on this axis to modify it. You 
can also click the tool axis (A) symbol in the Strategy tab page to modify the orientation of the 
reference axis.

6. Click Preview in the dialog box to verify the parameters that you have specified. A message 
box appears giving feedback about this verification. 

 7. A tool is proposed by default when you want to create a machining operation. If the proposed 

tool is not suitable, just select the Tool tab page  to specify the tool you want to use. 

Please refer to Edit the Tool of an Operation.

8. Select the Feeds and Speeds tab page  to specify the feedrates and spindle speeds for 

the operation.

9. Select the Macros tab page  to specify the operation's transition paths (approach and 

retract motion, for example). See Define Macros of an Operation for an example of specifying 
transition paths on a multi-axis machining operation. 

 10. Before accepting the operation, you should check its validity by replaying the tool path. 
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11. Click OK to create the operation.



Create a Multi-Axis Helix Machining Operation in 
Interpolation Mode

This task illustrates how to insert a Multi-Axis Helix Machining operation in the program. This operation 
will be used to generate a single helix toolpath to mill a blisk blade, while avoiding collisions with 
neighboring blades. 

The scenario below show how to quickly create an operation. The recommended procedure is described 
in Collision-Free Multi-Axis Helix Machining in the Methodology section.

To create the operation you must define: 

●     the geometry to be machined 

●     the tool that will be used 

●     the parameters of the machining strategy  with the tool axis guided in Interpolation mode

●     the feedrates and spindle speeds 

●     the macros (transition paths) .

Open the Blisk.CATPart document, then select Machining > Advanced Machining from the Start 
menu. Make the Manufacturing Program current in the specification tree.  
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The following procedure describes how to machine the middle (green) blade with no tool collisions with 
the two neighboring blades.

1. Select the Multi-Axis Helix Machining icon . A Helix Machining entity along with a default tool is 

added to the program. The Multi-Axis Helix Machining dialog box appears directly at the Geometry 

tab page . 

The part surface, upper and lower contours, and leading and trailing edges of the sensitive icon are 
colored red indicating that this geometry is required and must be selected. The upper and lower 
contours and the leading and trailing edges must lie on the faces selected as part surface.

Selection of check elements (such as neighboring blades or fixtures) is optional. 

2. Click the red part surface in the icon then select the faces to be machined in the 3D window. In this 
scenario, you must select 4 faces: the front face, the back face, the leading face, and the trailing 
face.

The Face Selection toolbar appears to help you select these faces. Note that faces must be 
continuous. Gaps between faces may result in a bad tool path.

3. Select the upper and lower contours. The Edge Selection toolbar appears to help you select these 
contours. They must be closed contours.

4. Select the leading and trailing edges to define the limits of the machining. The Edge Selection 
toolbar appears to help you select these edges. They must intersect the upper and lower contours.



  

●     The geometry entities of the icon are now colored green indicating that this geometry is now 
defined.

●     At this stage, make sure the Collision Checking option in the Geometry tab is deactivated.

 5. A tool is proposed by default when you want to create a machining operation. If the proposed tool 

is not suitable, just select the Tool tab page  to specify the tool you want to use. For 

example, you can create a conical mill tool with the following characteristics.



Please refer to Edit the Tool of an Operation for more information.

6. Select the Strategy tab page .

Set the Tool axis mode to Interpolation. 
Select a Start point by clicking on the sensitive icon then picking any point on the part surface.

file:///E|/www/jmndocr14/Doc/online/mfgug_C2/mfgugbt0201.htm


 7. Default Interpolation axes (I.1 to I.4) are displayed at the four corners of the part.

To modify an axis, double click on it and adjust the parameters in the dialog box that appears.

You can select the Display tool checkbox to help you do a rough visual check that the tool is 
correctly orientated. Note that the tool will be displayed according to the tool tip point (and not the 
contact point).

 8. Set the Machining parameters, for example:

 9. Set the Radial parameters, for example:



 10. Replay the tool path to verify that the tool can be positioned at each point on the trajectory. 

If the tool cannot be positioned at each point on the trajectory, adjust the default interpolation 
axes and possibly insert additional interpolation axes until this criteria is satisfied. 

You can add an additional axis by clicking one of the interpolation axis symbols in the Strategy tab 
page then either selecting an existing point on the part or selecting anywhere on the part.

You can delete an additional axis by right-clicking it and selecting the Remove contextual 
command.    
You can delete all additional axes by right-clicking one of the interpolation axis symbols in the 
Strategy tab page and selecting the Remove all additional axes contextual command.
Default axes cannot be removed.

Note that interpolation axes are applied at contact points on the trajectory. The application point of 
an interpolation axis must be on a selected face. If the point is not on a selected face, it will be 
projected onto the part. This may give undesirable results. 

Once the tool can be positioned at each point on the trajectory, you can set the collision checking 
option on the Geometry tab page.

 11. If there are collisions detected, adjust the interpolation axes until the tool path is collision free.

Once there are no collisions, you can select the faces of neighboring blades as check surfaces. 
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You can then replay the tool path to check for collisions with the selected faces.

 

 12. You may need to adjust the interpolation axes and possibly insert additional interpolation axes until 
the tool path is collision free.

The following figure shows an example of the default and additional interpolation axes that will give 
a collision-free trajectory.



 The corresponding data is as follows:

Axis Application point 
coordinates Interpolation axis vectors

1 Intersection point u=0.224917 v=0.0174524 
w=0.974222

2 Intersection point u=0.292194 v=-0.0348995 
w=0.955722

3 Intersection point u=0.15643 v=0 w=0.987688

4 Intersection point u=0.308264 v=0.0697565 
w=0.94874

5 x=-20.8009 y=18.814 
z=192.1 

u=-0.0688977 v=0.156434 
w=0.985282 

6 x=23.0488 y=-11.0264 
z=192.676

u=0.103351 v=-0.529919 
w=0.841727 

7 x=12.9556 y=-22.0174 
z=252 u=0 v=-0.45399 w=0.891007

8 x=-10.2918 y=16.9498 
z=252 

u=-0.069714 v=0.0348995 
w=0.996956 

9 x=-14.1239 y=9.91563 
z=192.142

u=0.25878 v=-0.0174524 
w=0.965779 

10 x=-4.66894 y=1.32628 
z=191.888

u=0.207785 v=-0.0348995 
w=0.977552 

11 x=-5.69227 y=-3.93598 
z=192.877

u=0.0347667 v=-0.0871557 
w=0.995588 

12 x=-20.6779 y=19.1817 
z=191.995

u=0.137059 v=0.173648 
w=0.975224

 13. The tool path can be replayed and checked for collisions.



14. Click OK to create the operation.

 
●     A default reference tool axis (A) is displayed. You can double click on this axis to modify it. You 

can also click the tool axis (A) symbol in the Strategy tab page to modify the orientation of the 
reference axis. This axis is not used in the interpolation.

●     If needed, you can select the Macros tab page  to specify the operation's transition paths 

(approach and retract motion, for example). See Define Macros of an Operation for an example 
of specifying transition paths on a multi-axis machining operation. 

●     If needed, you can select the Feeds and Speeds tab page  to specify the feedrates and 

spindle speeds for the operation.
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Auxiliary Operations
The tasks for inserting auxiliary operations in the manufacturing program are documented in the NC 
Manufacturing Infrastructure User's Guide.

Insert Tool Change: Select the Tool Change icon then select the tool type to be referenced in the 
tool change.
Insert Machine Rotation: Select the Machine Rotation icon then specify the tool rotation 
characteristics.
Insert Machining Axis Change: Select the Machining Axis Change icon then specify the 
characteristics of the new machining axis system.

Insert PP Instruction: Select the PP Instruction icon then enter the syntax of the PP instruction.

Insert COPY Operator (P2 functionality): Select the COPY Operator icon then select the 
reference operation. You can then specify the number of copies and the characteristics of the 
transformation.
Insert TRACUT Operator (P2 functionality): Select the TRACUT Operator icon then select the 
reference operation. You can then specify the characteristics of the transformation.
Insert Copy Transformation Instruction (P2 functionality): Select the Copy Transformation icon 
then select the reference operation. You can then specify the number of copies and the 
characteristics of the transformation.

Opposite Hand Machining: for machining symmetrical parts.
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Part Operations, Manufacturing Programs and 
Machining Processes

The tasks for creating and managing Part Operations, Manufacturing Programs and Machining Processes are 
documented in the NC Manufacturing Infrastructure User's Guide.

Create and Edit a Part Operation: Select the Part Operation icon then specify the entities to be 
referenced by the part operation: machine tool, machining axis system, tool change point, part 
set up, and so on.

Create and Edit a Manufacturing Program: Select the Manufacturing Program icon to add a 
program to the current part operation then insert all necessary program entities: machining 
operations, tool changes, PP instructions, and so on. 

Auto-sequence Operations in a Program (P2 functionality): Verify the administrator's settings 
for sequencing rules and priorities. If you are authorized, you can adjust these settings before 
applying the Auto-sequencing to your program.

Generate Transition Paths in a Program (P2 functionality): Automatically creates all necessary 
transition paths and machine rotations in the program according to the kinematics of the machine 
tool assigned to the Part Operation and user-defined transition planes.

Create a Machining Process (P2 functionality): Select the Machining Process icon to create a 
machining process, which can then be stored in a catalog.

Apply a Machining Process (P2 functionality): Select the Open Catalog icon to access the 
machining process to be applied to selected geometry.
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NC Manufacturing Entities
The tasks for creating and managing the specific entities of the Machining environment are documented in 
the NC Manufacturing Infrastructure User's Guide.

●     Edit the Tool of a Machining Operation: Double click the machining operation in the program and select 
the Tool tab page to edit the tool characteristics or search for another tool.

●     Edit a Tool in the Resource List: Double click a tool in the resource list and edit the tool characteristics in 
the Tool Definition dialog box.

●     Edit a Tool Assembly in the Resource List: Double click a tool assembly in the resource list and edit the 
tool characteristics in the Tool Definition dialog box.

●     Replace Tools in Resource List: Click the Replace Tools icon to rename tools already used in your 
document.

●     Specify Tool Compensation Information: Double click a tool referenced in the program or resource list 
and specify the tool compensation information in the Compensation tab page of the Tool Definition 
dialog box.

●     Create and Use Machining Patterns: Select Insert > Machining Feature > Machining Pattern then select 
a pattern of holes to be machined.

●     Manufacturing View: Select a feature using the Manufacturing view and create operations based on this 
feature.

●     Define Macros on a Milling Operation: Select the Macros tab page when creating or editing a milling 
operation, then specify the transition paths of the macros to be used in the operation.

●     Define Macros on an Axial Machining Operation: Select the Macros tab page when creating or editing an 
axial machining operation, then specify the transition paths of the macros to be used in the operation.

●     Build and Use a Macros Catalog.

●     Manage the Status of Manufacturing Entities: Use the status lights to know whether or not your 
operation is correctly defined.

●     Design or User Parameters in PP Instruction and APT Output.
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Verification, Simulation and Program Output
The tasks for using capabilities such as tool path verification, material removal simulation, and production 
of NC output data are documented in the NC Manufacturing Infrastructure User's Guide.

Replay Tool Path: Select the Tool Path Replay icon then specify the display options for an animated 
tool path display of the manufacturing program of machining operation.
Simulate Material Removal (P2 functionality): Select the desired icon in the Tool Path Replay 
dialog box to run a material removal simulation either in Photo or Video mode.

●     Generate APT Source Code in Batch Mode: Select the Generate NC Code in Batch Mode icon 
then select the manufacturing program to be processed and define the APT source processing 
options.

●     Generate NC Code in Batch Mode: Select the Generate NC Code in Batch Mode icon then select 
the manufacturing program to be processed and define the NC code processing options.

●     Generate Clfile Code in Batch Mode: Select the Generate NC Code in Batch Mode icon then 
select the manufacturing program to be processed and define the Clfile processing options.

●     Generate a CGR File in Batch Mode (P2 functionality): Select the Generate NC Code in Batch 
Mode icon then select the manufacturing program to be processed and define the CGR file 
processing options.

 
●     MfgBatch Utility that allows you to generate NC data files from a manufacturing program by 

means of an executable program under Windows or a shell under UNIX.

Batch Queue Management: Manage tool path computation outside the interactive session, with the 
possibility of scheduling the execution of several batch jobs.
Generate NC Code in Interactive Mode: Select the Generate NC Code Interactively icon to generate 
NC data for the current manufacturing program.
Generate Documentation: Select the Generate Documentation icon to produce shop floor 
documentation in HTML format. 
 Import an APT Source into the Program: Select the APT Import contextual command to insert an 
existing APT source into the current manufacturing program. 
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Tool Path Editor
 This is where you can find the functions you need to edit tool paths for all operations. 

Before using any of the functions below, you must have computed a tool path. 

All of the functions are accessed via the tool path contextual menu once the corresponding operation has 
been locked via its contextual menu.

Edit a Point 
Edit an Area

Split Tool Path on Collision Points
Apply Transformation to a Tool Path

Connect Tool Paths
Reverse a Tool Path

Manage Approach and Retracts in a Tool Path
Pack a Tool Path

Check Tool Path for Tool Holder Collisions
Create Geometry from a Tool Path

Tool Path Parameters
  



Editing a Point
This task explains how to either move or remove a point on a tool path.

You must have computed a tool path and have selected it in the PPR making it the current entity.

You must select points before any modification of the tool path.

1.  Open Block.CATProcess.

Expand the manufacturing process completely. Select the Sweeping.1 operation and 
check Lock in its contextual menu then select the tool path for the sweeping operation.

Select Point modification in the tool path contextual menu.
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 2.  The tool path and a dialog box are displayed. 

The dialog box offers several selection methods

●     As you pass the mouse cursor over the tool path you will notice that a small white square moves 

along the tool path. Click where you want to select a point.



●     The Selection bar  proposes other options.

 

3.  Once the points are selected, you can move them:

●     Pull the Distance arrow to the place you want the point to be in the viewer. The 

distance between the original position and the current position of the points is displayed 

as you move the arrow.

●     or enter the coordinates where they should be in the spin boxes. Just as above, an 

arrow is displayed as well as the distance from the original position of the points.

●     or double-click the word Distance and enter the distance in the box.

●     Use the contextual menu on Distance to select the translation direction

 



Push the Move button  to validate the modification. 

4.  To remove points, click the cut button .

Inserting a point
 This command enables you to insert a point in the tool path.

 

1.  Once the tool path and the dialog box are displayed, pick a point to select it.

2.  One point on each side of the selected point are proposed and visualized by a yellow cross. 

They are at the middle of the segment defined by the selected point and the next point on 

each side.

3.  Pick the proposed point you want to create and push the Insert button that is now available:



Note that the actions of the point 3 above apply the insertion of point too.



Editing an Area  
This task explains how to edit an area on a tool path. 

You can select areas of the tool path by using: 

●     one point on the tool path and deciding whether you want to use the portion before or after it,

●     two points and deciding whether you want to use the part of the tool path that is between the two 
points or outside of the two points,

●     a contour and deciding whether you want to use the part of the tool path that is inside or outside 
of the contour,

●     a polyline and deciding whether you want to use the part of the tool path that is inside or outside 
of the contour.

You must have computed a tool path and have selected it in the PPR making it the current entity. 

 

1.  Open Block.CATProcess.

Expand the manufacturing process completely. Select the Sweeping.1 operation and check 
Lock in its contextual menu then select the tool path for the sweeping operation.

Select Area modification in the tool path contextual menu. 

2.  The tool path and the tool path editor are displayed.

The tool path editor has options that let you select an area using: 

●      one point,

●      two points,

●      a contour,

●      a polyline,

●      collisions points, 

●     or by swapping the selection for the area that is not selected ,

so that you can then choose whether you what to move  or cut  the area. 
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You can also predefine the selection value . 

 

3.  First select the area that you want to modify:

●     by selecting one point on the tool path. This selects the portion of the tool path after 
the point.

●     by selecting two points on the tool path. This selects the portion of the tool path that 
falls between the two points.

●     by selecting an existing closed contour on the part. This selects the area of the tool 
path that is within the contour.



 

●     by clicking on the part to define a polyline. 

Double click to end selection.

 



4.  You can swap the selected area by clicking . So if you selected the area with: 

●     one point the part of the tool path that is before the point is now selected,

●     two points the part of the tool path that is outside the two points is now selected,

●     a contour the part of the tool path that is outside the contour is now selected.

Clicking the swap icon a second time will give you the original selection.

Use  to change the default value of the selected areas. Click it and this dialog box is 
displayed:

Depending on the button you pick, you can choose whether the part of the tool path 
selected is before or after the single point or inside or outside the two points or contour. 
Whichever of the buttons you choose its effect will be applied to the next tool path selection 
action.

5.  Now you can either cut the area of the tool path with  or move it with . 

  

To move a tool path area

●     grab the point at the end of the arrow beside the word Distance and pull.

Distance reflects the distance that you move the area. 

●     You can also double click  the word distance and enter a value in the dialog box.



●     If you wish to translate the area along an axis other than the (default) tool axis, use the 
contextual menu over the point at the end of the arrow beside the word Distance and 
choose an axis.

●     Once you are satisfied, push the Translate  icon.

 
If you cut an area and you do not reconnect the points, you will see the word "open" after the tool 

path name in the specifications tree.  

Before cutting an area of the tool path, you can choose to copy this area in the specification tree:

●     Push the Area selection option icon .

●     Check the Copy transformation option. Do not forget to exit this dialog box by OK.

●     Push the Cut icon  and select an operation in the specification tree. The Copy-
Transformation is created after the selected operation.



 

●     If you wish, you can change the tool of the Copy-Transformation you have created:

The specification tree will look like this:

6.  Click OK to close the tool path editor.



Split on Collision Points 
When the tool length is an important constraint, it may be useful to split the tool path of an operation in:

●     a tool path reachable by the specified tool,

●     a tool path reachable by a longer tool.

This task will show you how to do that quickly.
Open the CollisionSplit.CATProcess from the samples directory.

1.  Expand the specification tree, make sure Sweeping.1 is locked.

Select the Tool path under Sweeping.1 and select Split on collision points in the contextual menu.

The dialog box and the tool path are displayed.
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Extra geometry allows you to add additional geometry to the part in the operation where the tool path was computed. Additional geometry may be a face or a clamp that you would rather avoid using in 
the computation and that is not defined in the operation. 

There are other parameters that you may choose to modify: 

●     When you select Use part, the part you defined in the operation is used to compute the collision points.

●     Collision tolerance defines the distance within which the tool holder is considered to be in collision.

●     Offset on tool holder radius and Offset on tool length  define the tolerance distances specific to the tool holder radius and tool length.

 



       
2.  Once you have set the parameters, click Apply. The points in collision appear in red:

 

3.  Now select a longer tool (T5 End Mill D 10L50) in the New tool list:

4.  Click OK.



●     The dialog box is closed.

●     A Copy-Transformation containing the points in collision is created in the specification tree with a tool path that is computed with the new tool.

5.  Now close both tool path using the Connection or the Change approach and retract command.

 



Transformations
This task explains how to apply transformations to a tool path. You can: 

●     translate a tool path,

●     rotate a tool path,

●     mirror a tool path.

You must have computed a tool path and have selected it in the PPR making it the current entity.

1.  Open Block.CATProcess.

Expand the manufacturing process completely. Select the Sweeping.1 operation and check Lock in its contextual menu then select the tool path for the sweeping operation.

2.  Choose whether you want to translate, rotate or mirror-reflect the tool path.

 

3.        Translation

Choose Translation in the tool path contextual menu. 

The tool path is displayed on the part.

You can also translate the tool path by selecting it in  the viewer, clicking either on the approach or the retract and dragging. The contextual menu over the word "distance" lets you choose whether you want to translate the tool path along: 

●     the X axis,

●     the Y axis,

●     the Z axis,

●     or the tool axis.

and then pulling the tool path. You can also double click Distance and enter a value in the distance dialog box that is displayed.
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Click OK in the tool path translation dialog box to validate and exit the action.

 
Rotation

Choose Rotation in the tool path contextual menu. 

The tool path is displayed on the part. 

You can define the rotation you want with respect to: 

●     a  point; this defines the origin for the rotation,

●     an edge this defines the rotation axis,

●     a plane; the normal to the plane defines the rotation axis,

●     or a face; the normal to the face defines the rotation axis.

As you move the mouse over the tool path, the elements that can be used for the rotation are highlighted in red. By default the rotation is effected around the tool axis. 

Change the angle by double-clicking on the word Angle in the viewer (you can also drag the direction arrow in the viewer). A dialog box is displayed. 

 

Enter the number of degrees you want to rotate the tool path by.

For instance, a rotation of 90 will give you this result:

 

Click OK to validate and exit the action. 



 
Mirror

Choose Mirror in the tool path contextual menu. 

Choose a plane or a face to be the mirror plane. 

 

Double click to validate and exit the action.



Connecting Tool Paths
This task explains how to connect a tool path.

You must have computed a tool path, removed an area and have selected it in the PPR making it the current entity.

 

 

1.  Open BlockB.CATPRocess.

Expand the manufacturing process completely. Select the Sweeping.1 operation and check Lock in its 
contextual menu then select the tool path for the sweeping operation.

The tool path and a dialog box are displayed.

2.  Select the points to connect using the Selection bar 

3.  Select a connection mode using the Connection mode bar 
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4.  Click OK.

If you want to check the tool path, choose the operation that you used to create it and press Replay. You will see that 
the gap in the tool path is now closed.



Reversing a Tool Path
This task explains how to reverse a tool path.

You must have computed a tool path and have selected it in the PPR making it the current entity.

1.  Open Block.CATProcess.

Expand the manufacturing process completely. Select the Sweeping.1 operation and check 
Lock in its contextual menu then select the tool path for the sweeping operation

Choose Reverse in the tool path contextual menu. 

The tool path is reversed but not displayed. 

 
If you want to check the tool path, choose the operation that you used to create it and press replay. 
You will see that the tool approach and retract points have been exchanged.
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Tool Path Approaches and Retracts
This task explains how to add or remove approaches and retracts in a tool path.

You must have computed a tool path and have selected it in the PPR making it the current entity.

1.  Open Block.CATProcess.

2.  Expand the manufacturing process completely. Select the Sweeping.1 operation and check 

Lock in its contextual menu then select the tool path for the sweeping operation.

3.  Choose Change approach and retract in the contextual menu. A dialog box is displayed:
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You can delete:
●     approaches,

●     retracts,

●     linking passes,

●     passes between paths.

from the whole tool path or from a polygon that you draw on the tool path. 

1.  In the Delete frame, in the Filter section, check the appropriate boxes.

2.  Then push 

●     Remove from whole tool path button if you want to remove all occurrences or 

●     Remove from area inside polygon if you want to remove only the occurrences in a 

specific area. You have to define the area by drawing a polygon in the viewer. Double 

click to confirm and end it.

 

You can add:
●     approaches,

●     retracts 

1.  Choose the Approach or the Retract tab.

2.  Select the type of motion you want to use and modify the settings if necessary.



 3.  Press Apply. A message is displayed:

If you answer Yes, you will add an approach or a retract motion to the whole path.

If you answer No, use the Selection bar   to define an area to apply 
the approach or retract motion.

 

4.  If you are satisfied with the results press OK. If not, continue to make changes to the 

approach and retract tabs until you are. 

You can also modify:
●     existing approaches 

●     or existing retracts.

The operating mode is the same as above.
 



Packing and Unpacking a Tool Path
This task explains how to reduce the size of your CATProcess by packing the tool paths in it.

Open the Basic1.CATPart in the Samples directory. Select Surface Machining from the Start menu. 

Make the Manufacturing Program current in the specification tree.

Choose the Sweeping icon. Select the whole body as the part to machine.

Press Replay. This computes a tool path.

 

1.  Start by defining a directory for your new CATProcess. It is advisable to create a directory for 

each new CATProcess.

Go to the Tools > Options > NC Manufacturing option. Select the Output tab. Enter a 
directory for Tool path (first line).

 

2.  Select the computed sweeping operation in the specifications tree.
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In the contextual menu, choose Pack Tool Path. 

A message is displayed giving you the name of the file created and the name of the 
directory it is created in (i.e. the one you defined in the options). 

3.  You must pack each tool path for each individual operation in order to obtain a CATProcess 

that requires as little memory as possible when it is saved.

 
4.  When you start the tool path editor on a packed tool path, a message informs you that the 

tool path has been unpacked. You will have to pack the tool path again once you are finished.

When you have a CATProcess that contains a packed tool path and you copy the CATProcess 
anywhere else, the file containing the tool path does not follow and the tool path cannot be replayed 
on the new computer. Solve this by sending the CATProcess to the new computer via the using the 
File > Send to option rather than copying it.



Checking for Tool Holder Collisions
This task explains how to check a tool path to identify all the points where the tool holder collides 
with the part.

If you consider the tool alone, only the cutting length of the tool is taken into account.

If you consider the tool with its tool holder, the tool gage is taken into account.
Open the Basic1.CATPart in the Samples directory. Select Surface Machining from the Start menu. 

Make the Manufacturing Program current in the specification tree.

Choose the Sweeping icon. Select the whole body as the part to machine.

Press Replay. This computes a tool path. Select the Sweeping operation and check Lock in its 
contextual menu then select the tool path.

 

1.  Choose Check Tool Length in the tool path contextual menu.

A dialog box is displayed.

Extra geometry allows you to add additional geometry to the part in the operation where 
the tool path was computed. Additional geometry may be a face or a clamp that you would 
rather avoid using in the computation and that is not defined in the operation. 
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There are other parameters that you may choose to modify: 

●     When you select Use part, the part you defined in the operation is used to compute the 
collision points.

●     Collision tolerance defines the distance within which the tool holder is considered to 
be in collision.

●     Offset on tool holder radius and Offset on tool length  define the tolerance 
distances specific to the tool holder radius and tool length.

2.  Click Apply. 

The tool path is displayed on the part. The points where the tool holder is in collision with 
the part are shown in red.

A small dialog box is displayed that gives the number of collision points on this tool path, 



the minimum tool length that is required in order to avoid having collision points and the 
coordinates of the current point (move the mouse over the tool path to see the coordinates 
change for each point) plus reference data on the tool length and the offset on the tool 
length.

You can also display the tool on the tool path.

Click Cancel.

Close the dialog box 

This is only a visual check to let you see where the collision points are and find the tool length that is 
required to avoid them.

3.  You now have the choice of either changing the tool length or editing the tool path in order to 

get rid of the collision points.

If you want to change the tool length you must create a new tool or select another tool. 

4.  Select the tool path again in the specifications tree. Choose Area modification in the 

contextual menu.

The tool path is displayed. 

5.  Click the Select collision points icon .

The same dialog box as above is displayed. Change the parameter values if you wish.  



6.  Press Apply to display the collision points in red on the toolpath.

You can then cut ( ) the collision points from the tool path. 



Creating Geometries
This functionality enables you to preview and/or create geometry from the tool path, i.e. points, vectors 
representing axis or tool geometry for measurement operations.

This functionality 
●     is available for all machining operations with the exception of Lathe machining operations.

●     is available even if the tool path is unlocked.

 
You must have computed a tool path and have selected it in the PPR making it the current entity.

1.  Open Block.CATProcess.

Expand the manufacturing process completely. Select the Sweeping.1 operation and select 
the tool path for the sweeping operation.

Select Create Geometries in the tool path contextual menu.

The tool path and the dialog box are displayed:
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By default, the previsualization of points is requested.

2.  Place the cursor on the Destination field and select a destination body.

3.  Select an area of the tool path:

❍     push the button shown below,

❍     pick the first and the last points of the selection.



4.  Select Axes in the Creation box. They are displayed on the tool path.

5.  Click Apply, the axes are created under the Geometrical set Sweeping.1 . Click Close to exit 

the action

 
If you want to only visualize the geometry, do not push the Apply button since it would create the 
elements of the type selected.



Tool Path Editor Parameters
This information will help you edit and modify tool path.

 

Point modification parameters

Selection

Offers icons corresponding to different selection options.

 

 Multi-selection: push this icon and pick several points one by one. 

 Selection by sweep: push this icon, place the cursor over one point and drag the mouse. The 

points under the mouse path are selected.

 Selection between two points: push this icon, pick a first point, then a second point. All the 

points between those two points are selected.

 Selection by polyline: push this icon, draw a polyline around the points you want to select. The 

points inside this polyline are selected.

 Reverses the current selection.

 Resets all selections.

Action

Offers icons to cut or modify the points.

 cuts points.

 validates the modification.

To represent circles

x,y,z

Enter the new coordinates of the selected point.

Distance



●     Pull the arrow to draw the selected point to its new position.

●     Use the contextual menu of Distance to select the translation direction of the selected point: 

●     Along X axis,

●     Along Y axis,

●     Along Z axis,

●     Along tool axis,

●     Along last polyline, i.e. along a line created between the previous point and the point 
selected,

●     Along next polyline, i.e. along a line created between the next point and the point 
selected.

●     Or double-click  the word Distance and enter the distance in the box.

 

Area modification parameters

Selection Mode

●     Before/In selected geometry: The area of tool path selected is before the point selected, or 
between the two points selected.

●     After/Out selected geometry: The area of tool path selected is after the point selected, or outside 
the two points selected.

Copy transformation

Check this option to copy a cut area of the tool path in the specification tree.

Distance 

●     Pull the arrow to draw the selected area of the tool path to its new position.

●     Use the contextual menu of Distance to select the translation direction of the selected area of the 
tool path: 

●     Along X axis,

●     Along Y axis,

●     Along Z axis,

●     Along tool axis.

●     Or double-click  the word Distance and enter the distance in the box.

 



Translation parameters

Distance 

●     Pull the arrow to draw the selected area of the tool path to its new position.

●     Use the contextual menu of Distance to select the translation direction of the selected area of the 
tool path: 

●     Along X axis,

●     Along Y axis,

●     Along Z axis,

●     Along tool axis.

●     Or double-click  the word Distance and enter the distance in the box

 

Rotation parameters

Angle 

●     Pull the arrow to draw the selected area of the tool path to its new position.

●     Use the contextual menu of Angle to select the rotation axis of the selected area of the tool path: 

●     Rotation around X axis,

●     Rotation around Y axis,

●     Rotation around Z axis,

●     Rotation around  tool axis.

●     Or double-click  the word Angle and enter the angle in the box

 



 Connect parameters

Selection

Offers icons corresponding to different selection options.

 

 Multi-selection: push this icon and pick several points one by one. 

 Selection by sweep: push this icon, place the cursor over one point and drag the mouse. The 

points under the mouse path are selected.

 Selection between two points: push this icon, pick a first point, then a second point. All the 

points between those two points are selected.

 Selection by polyline: push this icon, draw a polyline around the points you want to select. The 

points inside this polyline are selected.

 Reverses the current selection.

 Resets all selections.

Connection mode

 Connects points directly

 Connects points through a plane

 Connects points through the safety plane of the operation.

Distance

Defines the distance the tool will rise to.

X, Y, Z and Nx, Ny, Nz 

Define the safety plane through a point and a normal. The connection will go through the point in the 
plane.

 



Change approach and retract parameters

Delete

Filter

Check the type of the path you want to delete:

●     Approach

●     Retract

●     Linking passes

●     Between paths

You can select several types.

Remove from whole tool path

The action takes the whole tool path into account.

Remove from area inside polygon

The action takes only the selected portion of the tool path into account. You select this portion by 
drawing a polygon on the tool path.

 

 Add/Modify

Selection

Offers icons corresponding to different selection options.

 

 Multi-selection: push this icon and pick several points one by one. 

 Selection by sweep: push this icon, place the cursor over one point and drag the mouse. The 

points under the mouse path are selected.

 Selection between two points: push this icon, pick a first point, then a second point. All the 

points between those two points are selected.

 Selection by polyline: push this icon, draw a polyline around the points you want to select. The 

points inside this polyline are selected.



 Reverses the current selection.

 Resets all selections.

Apply

Lets you define the domain of application: either the whole tool path or a portion selected with 

Selection.

 
Approach/Retract

Along tool axis 

The tool moves along the tool axis for a given Length. 

None 

No approach/retract.

 

Back 

The tool doubles back like an arrow above the cutting tool path. You can either define this type with 
Cartesian coordinates (Distance and Height) or Polar coordinates  (Angle and Radius). 



Circular 

The tool moves towards/away from the part in an arc. You can choose to compute the plane in which 
the tool moves either Automatically or Manually. The parameters that you can set are:

●     the Length,

●     the Angle

●     the Radius

●     the Normal vector to plane.

Box 

The tool moves across the diagonal of an imaginary box, either in a straight line or in a curve 
(Linking mode). The Length is the distance that the tool will move in once it has crossed the box. 
The box is defined by three distance values:

●     the distance along the tangent,

●     the distance along the tool axis (can be a negative value) ,

●     the distance along the normal axis,

●     The direction of the box diagonal is defined by whether you want to use the normal to the left or 
the right of the end of the tool path. Left or right of the Side of normal axis is determined by 
looking along the tool path in the direction of the approach/retract.



Check tool length parameters

Split on collision points parameters

Extra geometry (specific to Check tool length)

Allows you to add additional geometry to the part in the operation where the tool path was computed. 
Additional geometry may be a face or a clamp that you would rather avoid using in the computation 
and that is not defined in the operation.

Use part

Check this option to use the part you defined in the operation to compute the collision points.

Collision tolerance

Discretization distance to check for collision between the tool and the part.

Offset on tool holder radius (dR)

Safety distance for the tool holder radius to avoid collision between the holder and the part.

Offset on tool length (dL)

Safety distance for the tool holder length to avoid collision between the holder and the part.

Create Geometries parameters



Destination

Defines the partbody of the geometrical set where the geometry will be created.

Selection

: Selects the first point of the tool path.

: Selects the last point of the tool path.

: Selects all the points between the first point of the tool path and the point picked.

: Selects all the points between the point picked and the last point of the tool path.

: Selects all the points between two points picked.

: Selects all the points of the tool path.

You can also pick one point on the tool path.

Display

By default, the Previsualization option is activated, i.e. the element of the type selected below is 
visualized. You can deselect this option. However, the points of the tool path are always visualized.
If you want to only visualize the geometry, do not push the Apply button since it would create 
the elements of the type selected.



 Type

Select the type of elements you want to visualize or to create.

Points: Creates points.

Areas: Available if the type Points is selected, and if several points of the tool path are selected. 
Creates a join of lines from the portions of path selected.

Axes: Creates tool axes (as points and lines).

Tools: Creates tools (as revolves).

Apply

Apply becomes available once you have selected a Destination. It creates the elements of the type 
you have selected. Select an area and a type of elements to create, push Apply, then repeat these 
steps to create elements on several areas.

Close

Exit the action. The elements created by Apply are not erased.



Workbench Description
This section contains the description of the menu commands and icon toolbars that are specific to the Advanced Machining workbench, which 
is illustrated below. 

Menu Bar
Toolbars

Specification Tree

 



Advanced Machining Menu Bar
The various menus and menu commands that are specific to Advanced Machining are described below. 

Start File Edit View Insert Tools Windows Help

Tasks corresponding to general menu commands are described in the CATIA Version 5 Infrastructure User's Guide.

Tasks corresponding to common Machining menu commands are described in the NC Manufacturing Infrastructure User's Guide.

Insert Menu
Command... Description...
Machining Operations See Insert > Machining Operations

Machining Features Inserts Machining Features: 
●     Geometrical Zone

●     Machining Area

●     Rework Area

●     Prismatic Rework Area

●     Prismatic Machining Area

●     Offset Group

●     Machining Pattern

●     Machining Axis System feature, which is referenced in the 
Machining Axis Change auxiliary operation.

Auxiliary Operations See Insert > Auxiliary Operations

Insert > Machining Operations
 Command... Description... 

Axial Machining Operations Creates Axial Machining Operations 

Prismatic Machining Operations Creates Prismatic Machining Operations 

Surface Machining Operations Creates Surface Machining Operations 

Multi-Axis Machining Operations Creates Multi-Axis Machining Operations 

Insert > Machining Operations > Axial Machining Operations

Command... Description... 

Drilling Creates a Drilling Operation

Spot Drilling Creates a Spot Drilling Operation

Drilling Dwell Delay Creates a Drilling Dwell Delay Operation

Drilling Deep Hole Creates a Drilling Deep Hole Operation

Drilling Break Chips Creates a Drilling Break Chips Operation

Tapping Creates a Tapping Operation

Reverse Threading Creates a Reverse Threading Operation

Thread w/o Tap Head Creates a Thread without Tap Head Operation:

Boring Creates a Boring Operation

Boring and Chamfering Creates a Boring and Chamfering Operation

Boring Spindle Stop Creates a Boring Spindle Stop Operation

Reaming Creates a Reaming Operation
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 Counter Boring Creates a Counterboring Operation

Counter Sinking Creates a Countersinking Operation

Chamfering 2 Sides Creates a Chamfering Two Sides Operation

Back Boring Creates a Back Boring Operation

T-Slotting Creates a T-Slotting Operation

Circular Milling Creates a Circular Milling Operation

Thread Milling Creates a Thread Milling Operation

Insert > Machining Operations > Prismatic Machining Operations

 

Command... Description... 

Pocketing Creates a Pocketing Operation 

Facing Creates a Facing Operation 

Profile Contouring Creates a Profile Contouring Operation 

Curve Following Creates a Curve Following Operation

Point to Point Creates a Point to Point Operation 

Groove Milling Creates a Groove Milling Operation 

Insert > Machining Operations > Surface Machining Operations

 

Command... Description... 

Sweep Roughing Creates a Sweep Roughing Operation 

Roughing Creates a Roughing Operation 

Cavities Roughing Creates a Cavities Roughing Operation

Sweeping Creates a Sweeping Operation 

Pencil Creates a Pencil Operation 

ZLevel Creates a ZLevel Operation 

Contour Driven Creates a Contour Driven Operation 

Spiral Milling Creates a Spiral Milling Operation 

Isoparametric Machining Creates an Isoparametric Machining Operation

Insert > Machining Operations > Multi-Axis Machining Operations
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Command... Description... 

Multi-Axis Sweeping Creates a Multi-Axis Sweeping Operation 

Multi-Axis Contour Driven Creates a Multi-Axis Contour Driven Operation 

Multi-Axis Curve Following Creates a Multi-Axis Curve Following Operation 

Multi-Axis Flank Contouring Creates a Multi-Axis Flank Contouring Operation

Multi-Axis Helix Machining Creates a Multi-Axis Helix machining Operation
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Machining Operations Toolbar
The Advanced Machining workbench includes one specific icon toolbar: the Machining Operations toolbar. 
The other toolbars in the workbench are common to all the Machining products and are described in the NC 
Manufacturing Infrastructure User's Guide.

The Machining Operations toolbar contains the commands for creating and editing 2.5 to 5-axis Milling and 
Drilling operations.

The icons for creating and editing 2.5-axis Milling operations are as follows.

See Create a Pocketing Operation

See Create a Facing Operation

See Create a Profile Contouring Operation

See Create a Curve Following Operation

See Create a Point to Point Operation

See Create a Groove Milling Operation

The icons for creating and editing 3-axis Milling operations are as follows.

See Create a Sweep Roughing Operation 

See Create a Roughing Operation 

See Create a Cavities Roughing Operation

See Create a Sweeping Operation 

See Create a Pencil Operation 

See Create a ZLevel Operation 

See Create a Contour Driven Operation 

See Create a Spiral Milling Operation 

See Create an Isoparametric Machining Operation

The icons for creating and editing 5-axis Milling operations are as follows.

See Create a Multi-Axis Sweeping Operation 

See Create a Multi-Axis Contour Driven Operation 
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See Create a Multi-Axis Curve Following Operation 

See Create a Multi-Axis Isoparametric Operation 

See Create a Multi-Axis Flank Contouring Operation

See Create a Multi-Axis Helix Machining Operation

The icons for creating and editing Drilling operations as follows.

See Create a Drilling Operation

See Create a Spot Drilling Operation

See Create a Drilling Dwell Delay Operation

See Create a Drilling Deep Hole Operation

See Create a Drilling Break Chips Operation

See Create a Tapping Operation

See Create a Reverse Threading Operation

See Create a Thread without Tap Head Operation

See Create a Boring Operation

See Create a Boring and Chamfering Operation

See Create a Boring Spindle Stop Operation

See Create a Reaming Operation

See Create a Counterboring Operation

See Create a Countersinking Operation

See Create a Chamfering Two Sides Operation

See Create a Back Boring Operation

See Create a T-Slotting Operation

See Create a Circular Milling Operation

See Create a Thread Milling Operation
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Specification Tree
Here is an example of a Process Product Resources (PPR) specification tree for Advanced Machining.

Process List is a plan that gives all the activities and machining operations required to transform a part 
from a rough to a finished state. 

●     Part Operation defines the manufacturing resources and the reference data.

●     Manufacturing Program is the list of all of the operations and tool changes performed. The example 
above shows that: 

●     Drilling.1 is complete and has not been computed

●     Drilling.2 is complete but has been computed (by means of a replay)

●     Drilling.3 does not have all of the necessary data (indicated by the exclamation mark 
symbol)

●     Drilling.4 has been deactivated by the user (indicated by the brackets symbol)

●     Drilling.5 has been modified and needs to be recomputed (indicated by the update symbol).



Product List gives all of the parts to machine as well as CATPart documents containing complementary 
geometry. 
Resources List gives all of the resources such as machine or tools that can be used in the program.



Customizing

This section describes how to customize settings for Machining.

Before you start your first working session, you can customize the settings to suit your working habits. Your 
customized settings are stored in permanent setting files: they will not be lost at the end of your session.

Other tasks for customizing your Machining environment are documented in the NC Manufacturing Infrastructure 
User's Guide:

Build a Tools Catalog
Access External Tools Catalogs
Add User Attributes on Tool Types 
PP Word Syntaxes 
NC Documentation 
Workbenches and Tool Bars

1. Select Tools > Options from the menu bar: the Options dialog box appears. 

2. Select the Machining category in the tree to the left. The options for Machining settings appear, organized in tab 
pages. 

3. Select the tab corresponding to the parameters to be customized.

Parameters in this tab... Allow you to customize...

General general settings for all Machining products

Resources tooling, feeds&speeds and resource files 

Operation machining operations

Output PP files and NC data output

Program manufacturing programs (sequencing, and so on)

Photo/Video material removal simulation 

4. Set these options according to your needs. 

5. Click OK to save the settings and quit the Options dialog box. 
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General

This document explains how to customize general settings for Machining products.

Select the General tab, which is divided up into areas.

Parameters in this area... Allow you to customize...

Performance settings for optimized performance

Tree Display display of the specification tree

Color and Highlight colors of displayed geometry and parameters

Tool Path Replay tool display during tool path replay

Complementary Geometry handling of geometry necessary for manufacturing

Design Changes use of the Smart NC mode and enhanced detection of design 
changes.

Performance

Click the Optimize button in order to automatically set a number of the Machining options for optimized performance. These 
options are listed in the Information dialog box that appears: 



If you click Yes, these options will be set as described in the dialog box. Note that, if needed, you may locally reset any of 
these options.
If you click No, the options will remain with their current settings.

The Information box also lists some recommendations for manually setting other options that have an influence on 
performance. 

Tree Display

●     Select the checkbox if you want the status of activities in the tree to be updated automatically. 

●     If this checkbox is not selected:

❍     you can update activity status manually in your workbench using the Update Status icon  in the Auxiliary 
Commands toolbar. 

❍     the status of the activity after a manual update is masked at the first action on the node (for example, edit, replay, 
collapse/expand of a parent node). To retrieve the status of the activity you must select the Update Status icon 
again. 



If this checkbox is not selected, performance is improved.

 By default, the checkbox is not selected.

Color and Highlight

●     Select the colors to be used for identifying the various manufacturing entities by means of the combos. 
Note that for Geometry that is not found or not up to date, you can select the colors used to display the valuated 
parameters in the corresponding Operation or Feature dialog boxes.

●     For certain entities, you can select the corresponding checkbox to use highlighting. 
Performance is improved when all the Highlight checkboxes are selected.

Tool Path Replay

Display tool near cursor position on tool path

Select this checkbox if you want to display the tool near your cursor position on the trajectory during a tool path replay

Display tool center instead of tool tip

Select this checkbox if you want to display the tool center point instead of the tool tip during a tool path replay



Display circles

Select this checkbox if you want to display each circular trajectory as a circular arc instead of a set of discretization points. 
The extremities of the circular arc are indicated by means of 'O' symbols.
This allows better control of the Point by Point replay mode, where it is necessary to make several interactions to replay a 
circle (because of its representation by a set of points). With the graphic representation as a circle, only one interaction is 
necessary to perform the replay.

 By default, these checkboxes are not selected.

Color of feedrates

Select the colors to be used for identifying the various feedrate types by means of the combos. The selected colors will be 
displayed in the Different colors replay mode.

Complementary Geometry

Select the checkbox to create a CATPart dedicated to manufacturing-specific geometry in the Product List of the PPR tree.

 By default, the checkbox is not selected.

Design Changes

Smart NC mode

Select this checkbox to activate the Smart NC mode. In this mode, an image of the geometry selected in machining 
operations is kept to allow analysis of design changes.
Performance is improved when this checkbox is not selected.

Optimized detection of design changes

Select this check box to enable a geometrical comparison mode in order to more precisely determine the design change 
status of machining operations.

 By default, these checkboxes are not selected.



Resources

This document explains how to customize resource settings for Machining products.

Select the Resources tab, which is divided up into areas. 

Parameters in this area... Allow you to customize...

Catalogs and Files the path name for resource files

Tool Selection the selection of tools

Automatic Compute from Tool Feeds and 
Speeds

the update of feeds and speeds according to tooling data

Tool Query Mode in Machining Processes 
Instantiation

tool queries in machining processes

Catalogs and Files 

Enter the path of the folder containing tool catalogs, PP tables, macros, and machining processes. You can choose a folder by clicking 
the [...] button.

You can concatenate paths using:

●     a semi colon (;) character for Windows NT platforms.

●     a colon (:) character for UNIX platform.

For example, if the concatenated folders E:\DownloadOfCXR12rel\intel_a\startup and e:\users\jmn\NC in the figure above contain PP 
tables, then those PP tables will be available for selection in the Part Operation's Machine Editor dialog box.

Please note that:

●     PP tables must be contained in folders named Manufacturing\PPTables

●     tools must be contained in folders named Manufacturing\Tools.

Tool Selection 

Automatic query after modification

Select this checkbox if you want to to activate an automatic query after each modification of a tool parameter. Performance is improved 
when this checkbox is not selected.

Tool preview after selection

Select this checkbox if you want to preview the tool after selection.

 By default, these checkboxes are selected.



Automatic Compute from Tool Feeds and Speeds

Feedrate attributes of the operation

Select this checkbox if you want the Automatic Update of Feedrates option to be set by default in the Feeds and Speeds tab page of 
machining operations.
This option allows feedrates of operations to be automatically updated whenever feedrate information on the tool is modified.

Spindle attributes of the operation

Select this checkbox if you want the Automatic Update of Speeds option to be set by default in the Feeds and Speeds tab page of 
machining operations.
This option allows spindle speeds of operations to be automatically updated whenever speed information on the tool is modified.

 By default, these checkboxes are selected.

Tool Query mode in Machining Processes Instantiation

Select the type of Tool Query to be executed when a Machining Process is instantiated:

●     automatically computed Tool Query

●     interactively defined Tool Selection in case of multiple results

●     interactively defined Tool Selection if no tool is found.

Depending on the selected option, the Advanced tab page of the Search Tool dialog box shows the solved Tool Query for each operation 
in the Machining Process.

 By default, the Automatic Tool Query option is selected.

In the example below, you can choose one of the tools found in the ToolsSampleMP, or use the Look in combo to select a tool from 
the current document or another tool catalog. 





Operation

This document explains how to customize machining operation settings for Machining products.

Select the Operation tab, which is divided up into areas. 

Parameters in this area... Allow you to customize...

Default Values the use of default values

After Creation or Machining Process (MP) 
Instantiation

what happens after creating machining operations or machining 
processes

When Copying the duplication of geometry links

Display tool path displays of operations

User Interface dialog boxes of 3-axis surface machining operations.

Default Values

Select the checkbox if you want operations to be created with the values used in the current program. 
The values and units of attributes at the creation step of an operation are set to the values and units of the last edited and 
validated operation whatever its type (that is, exit the operation definition dialog box using OK).

Otherwise the default settings delivered with the application are used.

 By default, this checkbox is selected.

After Creation or Machining Process (MP) Instantiation

Select the desired checkboxes to specify conditions to be applied when you create machining operations or machining 
processes.

Sequence machining operation

Machining operations are automatically sequenced in the current program after creation. 
Otherwise, sequencing can be managed in the feature view.

Search compatible tool in previous operations

When creating an operation, if a compatible tool exists in a previous operation of the current program, it will be set in the 
new operation. 
Otherwise, the operation will be incomplete.



Use a default tool

When creating an operation, a search is done in the document to find a compatible tool. If no compatible tool exists, a 
default one is created in the document and set in the created operation.
If checkbox is not selected, no tool will be defined on the operation.

Start edit mode (not available for machining processes)

When creating a machining operation, Edit mode is automatically started to allow modifying parameters of the created 
operation.
Otherwise, the operation is added to the program but the machining operation editor is not started.

 By default, these checkboxes are selected.

When Copying

Select the checkbox if you want geometry links to be duplicated in a copied operation.

Otherwise the geometry must be defined for the copied operation. Performance is improved when this checkbox is not 
selected.

 By default, this checkbox is selected.

Display

Select the checkbox if you want to display tool paths of operations in the current Part Operation.

 By default, this checkbox is not selected.

User Interface

Select the checkbox if you want to have the possibility of simplifying the dialog boxes of machining operations (that is, you 
can display the minimum number of parameters necessary for a correct tool path). This setting is available for 3-axis surface 
machining operations only. 

 By default, this checkbox is not selected.



Output

This document explains how to customize data output settings for Machining products.

Select the Output tab, which is divided up into areas. 

Parameters in this area... Allow you to customize...

Post Processor the type of PP files to be used for generating NC code output and 
the path where these files are located

Tool Path Storage the tool path storage capability

Tool Path Edition the tool path edition capability

During Tool Path Computation contact point storage

Tool Output Point type of tool output point

Tool Output Files ... Location default paths for NC output files storage.

Post Processor

Select the desired Processor option:

●     None: no Post Processor is defined. NC code output is not possible in this case

●     Cenit: you can choose from among the Post Processor parameter files proposed by Cenit to generate your NC code

●     IMS: you can choose from among the Post Processor parameter files proposed by Intelligent Manufacturing Software 
(IMS) to generate your NC code

●     ICAM: you can choose from among the Post Processor parameter files proposed by ICAM Technologies Corporation 
(ICAM) to generate your NC code.

Enter the path of the folder containing Post processors. You can choose a folder by clicking the [...] button. File 
concatenation is possible.

 By default, the None option is selected.

Tool Path Storage



Select the desired option to store tool path data either in the current document or in an external file (as a tpl file).

For operations with large tool paths (more than 100 000 points), tool path storage in an external file is recommended. 

 By default, the Store tool path in the current document option is selected.

Tool Path Edition

Select the checkbox if you want to be able to edit tool paths even when the operation is locked. 

This capability is available only for activities with a tool path node in the specification tree.

 By default, this checkbox is selected.

During Tool Path Computation

Select the checkbox if you want to store contact points in the tool path.

Performance is improved when this checkbox is not selected.

 By default, this checkbox is selected.

Tool Output Point

Select the desired option to select one of the following as output point:

●     tool tip

●     tool center point

●     tool center point for ball end tools (that is, any tool with the Ball-end tool attribute selected or an end mill whose nominal 
diameter is equal to twice the corner radius).

Performance is better when the Tool Tip option is selected.

 By default, the Tool Tip option is selected.

Default File Locations



Specify default locations for storing Tool Path files, NC Documentation, and NC Code output. 

You can store tool paths files (tpl files) in the same folder as the CATProcess by selecting the checkbox. This allows you to 
store these files according to your CATProcess context. Otherwise, you can choose another location by clicking the [...] 
button.

For NC Documentation, and NC Code output you can choose a folder easily by clicking the [...] button. 

You can customize the extension to be used for NC Code output (by default, the suffix used is CATNCCode).

 By default, the Tool path: Store at same location as the CATProcess checkbox is not selected.



Program

This document explains how to customize manufacturing program settings for Machining products.

Select the Program tab to customize program auto-sequencing rules and priorities. These settings are 
mainly intended for the administrator.

Make sure that the document in the sequencing rules path (AllSequencingRules.CATProduct in the example 
below) is accessible in Read/Write.

Auto Sequencing

 

Access to sequencing rules settings

Select the Access to sequencing rules settings checkbox to authorize user access to sequencing rules.

You can then specify the path for the rules base 
You can choose a rules base easily by clicking the [...] button.

 By default, this checkbox is selected.

Display sequencing rules and priorities

Select the Display sequencing rules and priorities checkbox to authorize the display of sequencing rules 
and priorities in the user's view. In this case two more checkboxes can be selected in order to: 

●     allow the user to filter rules 

●     allow the user to modify rule priorities.

 By default, these checkboxes are selected.



Photo/Video

This document explains how to customize material removal simulation settings for NC Manufacturing products.

Select the Photo/Video tab, which is divided up into areas. 

Parameters in this area... Allow you to customize...

Simulation at material removal simulation at program of Part Operation level

Video Video material removal simulation options

Photo Photo material removal simulation options

Performance settings that influence performance

Color color during material removal simulation

Positioning Move allowed tool axis variation between two operations

Simulation at 

Select the desired option to perform material removal simulation at either Program or Part Operation level. 
Depending on the selected level, simulation begins either from the start of the manufacturing program or from the start of 
the Part Operation. 
Best performance is obtained with Program level.

 By default, the Program level option is selected.

Video 

Stop at tool change

Select the Stop at tool change checkbox if you want the Video simulation to stop each time a tool change is encountered 
in the program.

 By default, this checkbox is not selected.

Collision detection

Select the desired Collisions detection option to: 

●     ignore collisions during the Video simulation



●     stop the Video simulation at the first collision

●     continue the Video simulation even when collisions are detected. In this case, you can consult the list of collisions at any 
time during the simulation.

Best performance is obtained when collisions are ignored.

 By default, the Ignore option is selected.

Touch is collision

Select the Touch is collision checkbox if you want touch (or contact) type of collision to be detected. 

 By default, this checkbox is selected.

Multiple Video result on program

Select the Multiple Video result on program checkbox if you want to store video results on more than one operation in 
the program.

 By default, this checkbox is not selected.

Photo

Select the desired Fault box type for examining remaining material or gouges:

●     Transparent: to display a transparent bounding box

●     Wireframe: to display a wireframe bounding box

●     None: if no bounding box is required.

Best performance is obtained when no bounding box is required and the checkbox is not selected.

 By default, the Wireframe option is selected.

Select the checkbox to compute all information at picked point.

 By default, this checkbox is not selected.

Best performance is obtained when Fault box: None is selected and the checkbox is not selected.

Performance 



Tool and faceting

There are three methods of tool faceting used in Video simulation: Standard, Smaller and Larger. 
The number of facets for a tool representation is determined by the chord deviation that is set for the tool diameter (0.005% 
of the tool diameter). 

●     Smaller: The picture shows a rough approximation of a tool with six facets. Note that the chord deviation is always 
inside the actual circle, and that the points are always on the circle (accurate).  

This is the most accurate method for the Arc through Three Points command.

●     Standard: The picture shows a rough approximation of a tool with six facets. Note that the chord deviation is partly 
inside and partly outside the actual circle, and that the points are not always on the circle.

This is the best method for material removal simulation. 
However, this is not suitable for the Arc through Three Points command.

●     Larger: The picture shows a rough approximation of a tool with six facets. Note that the chord deviation is outside the 
actual circle, and that the points are not on the circle.



This is not suitable for the Arc through Three Points command.
However, it can be useful for gouge detection.

 By default, the Standard option is selected.

Photo resolution

Best performance is obtained when the Photo resolution is set to 0. In this case, a detailed simulation of a portion of the part 
can be obtained using the Closeup command.
Increasing the resolution improves machining accuracy and gives a very detailed simulation. However, this requires 
increased memory and computation time.

 By default, this resolution is set to 0.

Tool axis interpolation angle (5-axis only)

Specify the maximum angle that the tool axis is allowed to vary between two consecutive points. 
Best performance is obtained for an angle of 10 degrees. Decreasing the angle improves the precision of the simulation. 
However, this requires increased memory and computation time.

 By default, this angle is set to 1degree.

Optimized rendering for Video

Set the Optimized rendering for Video checkbox to obtain an optimized rendering that improves Video simulation 
performance.
Otherwise, more realistic colors are obtained with a slightly degraded performance. Milling, drilling, and turning operations 
are supported.

 By default, this checkbox is selected.

Color 



Set the tool (and associated machined area) color to be the same as or different from the last tool, or have different colors 
for all tools. Best performance is obtained with same colored tools.

 By default, the All different option is selected.

Assign colors to the different tools using the associated color combo.

Assign colors to tool holders, parts, and fixtures using the associated color combos.

Positioning Move

Set the Maximum tool axis variation that is to be allowed between the end point of an operation and the start point of 
the next operation. If the tool axis varies by an amount greater than the specified value, then the tool is positioned at the 
start of the following operation.

 By default, this angle is set to 1degree.



Reference Information
Reference information that is specific to the Advanced Machining product can be found in this section.

Multi-Axis Flank Contouring 
Multi-Axis Helix Machining 

Cavities Roughing

Reference information on the following topics is provided in the Multi-Axis Surface Machining User's Guide. 

Multi-Axis Sweeping
Multi-Axis Isoparametric Machining

Multi-Axis Contour Driven
Multi-Axis Curve Machining

Collision Checking

Reference information on the following topics is provided in the 3-Axis Surface Machining User's Guide. 

Sweep Roughing
Roughing
Sweeping

ZLevel
Spiral Milling

Contour-driven
Pencil

Isoparametric Machining
Machining/Slope Areas

Reference information on the following topics is provided in the Prismatic Machining User's Guide.

Pocketing
Profile Contouring

Facing
Curve Following
Point to Point

Axial Machining

Essential reference information on the following topics is provided in the NC Manufacturing Infrastructure 
User's Guide.

NC Manufacturing Resources
NC Macros

PP Tables and PP Word Syntaxes
Feeds and Speeds

APT Formats
CLfile Formats 
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Multi-Axis Flank Contouring Operations
The information in this section will help you create and edit Multi-Axis Flank Contouring operations in your manufacturing 
program.

Select the Multi-Axis Flank Contouring operation  icon then select the geometry  to be machined.

A number of strategy parameters  are available for defining:

●     machining criteria

●     axial and radial stepover conditions

●     finishing

●     tool axis guidance

●     high-speed milling

●     cutter compensation.

Specify the tool to be used , feeds and speeds , and NC macros  as needed.

The following user tasks illustrate some of this operation's capabilities:

●     Tanto Fan tool axis mode

●     Combin Tanto tool axis mode

●     Local modifications 

●     Non-contiguous drives.

Multi-Axis Flank Contouring: Strategy Parameters

Multi-Axis Flank Contouring: Machining Parameters
Machining tolerance
Specifies the maximum allowed distance between the theoretical and computed tool path. 
Maximum discretization step
Defines the maximum allowed distance between two points on the tool path. It is used to ensure linearity between points 
that are far apart. Default value is 100 m.
Maximum discretization angle
Specifies the maximum angular change of tool axis between tool positions. It is used to add more tool positions (points and 
axis) if value is exceeded. Default value is 180 degrees.
Note: The Maximum discretization step and Maximum discretization angle influence the number of points on the tool path. 
The values should be chosen carefully if you want to avoid having a high concentration of points along the tool trajectory. 
These parameters also apply to macro paths that are defined in machining feedrate. They do not apply to macro paths that 
do not have machining feedrate (RAPID, Approach, Retract, User, and so on).
Close tool path
For a closed contour, specifies that the first drive is also to be used as the last drive. 
Maximum distance between steps
Specifies the maximum distance between points. It is used to detect the end of drive elements. 
Manual direction
Specifies the direction on the first drive.
Otherwise, it is determined automatically depending on the reference position. 

Multi-Axis Flank Contouring: Stepover Parameters
Tool path style
Indicates the cutting mode of the operation: 
Zig Zag: the machining direction is reversed from one path to the next
One Way: the same machining direction is used from one path to the next.



Sequencing
Specifies the order in which machining is to be done: 

●     Axial: axial machining is done first then radial

●     Radial: radial machining is done first then axial.

Distance between paths (radial)
Defines the maximum distance between two consecutive tool paths in a radial strategy. 
Number of paths
Defines the number of tool paths in a radial strategy. 
Axial strategy mode
Defines how the distance between two consecutive levels is to be computed. 
Distance between paths (axial) 
Defines the maximum distance between two consecutive tool paths in an axial strategy. 
Number of levels
Defines the number of levels to be machined in an axial strategy. 

Multi-Axis Flank Contouring: Finishing Parameters
Finishing mode
Indicates whether or not finish passes are to be generated on the sides and bottom of the area to machine. Side finishing 
can be done at each level or only at the last level of the operation. 
Side finish thickness
Specifies the thickness used for side finishing. 
Side finish thickness on bottom
Specifies the thickness used for the last side finish pass at the end of the operation. 
Bottom finish thickness
Specifies the thickness used for bottom finishing. 
Bottom finish path style
Defines the bottom finish path style: Zig zag or One way. 
Spring pass
Indicates whether or not a spring pass is to be generated on the sides in the same condition as the previous Side finish 
pass. The spring pass is used to compensate the natural `spring' of the tool. 

Multi-Axis Flank Contouring: Tool Axis Parameters
Tool axis guidance
Specifies how the tool axis is to be guided. 



●     Tanto Fan: The tool is tangent to the drive surface at a given contact height, and the tool axis is interpolated between 
the start and end positions.

●     Combin Tanto: This strategy combines three phases:
❍     tool fans over a given Leave distance

❍     tool is tangent to the drive surface at a given Contact height and is contained in a plane normal to forward direction

❍     tool fans over a given Approach distance.

●     Combin Parelm: This strategy combines three phases:
❍     tool fans over a given Leave distance

❍     tool is tangent to the drive surface at a given Contact height and follows the surface isoparametrics

❍     tool fans over a given Approach distance.



●     Mixed Combin: Either Combin Parelm or Combin Tanto is applied depending on the drive surface geometry. Combin 
Tanto is applied for cylindrical and planar drives. Combin Parelm is applied for other drive surface geometry.

●     Fixed: The orientation of the tool axis is fixed. 

 

●     Normal to Part: The tool axis remains normal to the Part Surface while the tool remains in contact with the drive 
surface. 



●     Tanto: This mode can only be assigned locally to a drive and not globally to the operation. The tool is tangent to the 
drive surface at a given contact height, and the tool axis is contained in a plane normal to forward direction. 

Contact height
Determines a point on the drive surface where the tool must respect tangency conditions. The Contact height is measured 
from the tool tip along the tool axis. The point on the drive is computed such that its projection normal to the drive onto the 
tool axis respects the Contact height value. 



 

Leave fanning distance
Specifies a distance at the start of a motion over which tool fanning takes place. 

Approach fanning distance
Specifies a distance at the end of a motion over which tool fanning takes place. 

Disable fanning
For operations with Combin Tanto, Combin Parelm and Mixed Combin tool axis guidance, it is possible to disable fanning at 
Start element, at Stop element, or at both these limiting elements. 

Control fanning using tool parameter
When this option is selected, a Useful cutting length can be defined on the current tool. This parameter is helpful for 
controlling tool fanning or the offset distance when approaching drive surfaces with negative draft angles, without needing 
to modify the tool chosen in the database.  

Otherwise, the default standard cutting length value (Lc) of the tool will be used.

An auxiliary guide curve can be selected in order to modify the tool axis strategy. It is mainly used to avoid collisions at the 
top of drive elements or to keep a safety distance on these elements. The following parameters can be used if a guide curve 
is selected the guide curve. 

Position on guide curve
Tool positioning with respect to the guide curve: Auto/Right/Left/On. Auto lets the program determine the best position 
regarding the curve.

Offset on guide curve
Offset to be applied to the guide curve.

Use of guide curve
Tool can be made to respect the guide curve either Always or If needed (that is, only where there is a risk of  collision 
with the drive element).

For example, for the following geometry:



A collision occurs if top auxiliary guide curve is not 
defined:

 

Collision is avoided if top auxiliary guide curve is defined:

Multi-Axis Flank Contouring: High Speed Milling (HSM) Parameters

In a Multi-Axis Flank Contouring, cornering for HSM applies to all corners for machining or finishing passes. It does not apply 
to macros or default linking and return motions.

Cornering
Specifies whether or not cornering is to be done on the trajectory for HSM. 



Corner radius
Specifies the radius used for rounding the corners along the trajectory of a HSM operation. Value must be smaller than the 
tool radius. 

Cornering on side finish path
Specifies whether or not tool path cornering is to be done on side finish paths. 
Corner radius on side finish path
Specifies the corner radius used for rounding the corners along the side finish path of a HSM operation. Value must be 
smaller than the tool radius. 

Multi-Axis Flank Contouring: Cutter Compensation Parameters

In the Machine Editor, the Compensation tab contains options for: 

●     globally defining the 3D contact cutter compensation mode: None/Contact/Tip and Contact

●     imposing the compensation mode to all operations supporting the selected mode whatever the choice defined at 
machining operation level.

If the options are set as follows, compensation can be managed at machining operation level.

In this case a Compensation tab appears in the Strategy page of the machining operation editor, and the following options 
are available.

Compensation output
Allows you to manage the generation of Cutter compensation (CUTCOM) instructions in the NC data output:

The following options are proposed:

●     3D radial (PQR)

●     2D radial tip

●     None.

3D Radial (PQR)

You can generate 3D radial compensation data (Vector <P,Q,R>) in the APT output.

The Radial compensation data output can be activated or not on each Multi Axis Flank Contouring cycle of a program.

For all tool positions of the machining passes, for the last motion of each approach macro, and for the first motion of each 
retract macro, the <PQR> vector is added to the APT statement (which contains the Tip position and the Tool Axis.
Before the first position with <PQR> data, two APT statements : CUTCOM/SAME,NORMDS and CUTCOM/NORMDS are 
automatically added, after the last position with <PQR> data, a CUTCOM/OFF statement is automatically added.
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These PQR statements are supported and can be translated by Multi-Axis Post Processors provided NC manufacturing 
Workbenches.

A sample APT output is given below:

MULTAX/ ON
PARTNO/ 0001 TEST G29 
PPRINT/ %0001
MACHIN/ N76TO1, 1.0000, 1.0000
LOADTL/ 1.0000, LENGTH, 100.0000
FROM/ 0.0000, 0.0000, 100.0000, $
0.0000, 0.0000, 1.0000
RAPID
GOTO/ -20.0000, -20.0000, 100.0000, $
0.0000, 0.0000, 1.0000
FEDRAT/ 150.0000,MMPM
RAPID
GOTO/ -20.0000, -20.0000, 5.0000, $
0.0000, 0.0000, 1.0000
RAPID
GOTO/ -20.0000, -20.0000, 5.0000, $
0.1711, 0.1711, 0.9703
CUTCOM/ SAME, NORMDS
CUTCOM/ NORMDS
RAPID
GOTO/ -5.0000, -14.7721, 2.6047, $
0.1711, 0.1711, 0.9703, $
0.9806, -0.1247, -0.1509
RAPID
FEDRAT/ 150.0000,MMPM
GOTO/ -4.9039, -13.8115, 2.4353, $
0.1711, 0.1711, 0.9703, $
0.9440, -0.3105, -0.1117
GOTO/ -4.6194, -12.8878, 2.2725, $
0.1711, 0.1711, 0.9703, $
0.8718, -0.4852, -0.0682
GOTO/ -4.1573, -12.0365, 2.1223, $
0.1711, 0.1711, 0.9703, $
0.7661, -0.6423, -0.0218

.../...

GOTO/ -12.8878, -4.6194, 2.2725, $
0.1711, 0.1711, 0.9703, $
-0.4852, 0.8718, -0.0682
GOTO/ -13.8115, -4.9039, 2.4353, $
0.1711, 0.1711, 0.9703, $
-0.3105, 0.9440, -0.1117
GOTO/ -14.7721, -5.0000, 2.6047, $
0.1711, 0.1711, 0.9703, $
-0.1247, 0.9806, -0.1509
CUTCOM/ OFF
FEDRAT/ 150.0000,MMPM
GOTO/ -34.7721, -5.0000, 2.6047, $
0.1711, 0.1711, 0.9703
RAPID
GOTO/ -33.0612, -3.2891, 12.3076, $
0.1711, 0.1711, 0.9703
RAPID
GOTO/ -33.0612, -3.2891, 12.3076, $
0.0000, 0.0000, 1.0000
RAPID
GOTO/ -33.0612, -3.2891, 100.0000, $
0.0000, 0.0000, 1.0000

A sample of NC data file is given below:

%0001
N1(TOTAL MACHINING TIME : 0 HOURS AND 4 MINUTES)



N1( 0001 TEST G29 21-May-2001 14:05:10.00)
/N3E62001=-100000
N5E30008=100000
N7E30009=100000D0
N9G52T1M6M36
N11D1
/N13M0
$(RP0001)
N15G0X0Y0Z351A0B0
N17X-20Y-20
N19G0Z256
N21X22.947Y22.947Z248.541A-10.001B9.852
N23G29X37.947Y28.175Z246.145A-10.001B9.852U.171V.171W.97P-980.6Q124.7R150.9
N25G94F150G1X38.043Y29.136Z245.976A-10.001B9.852U.171V.171W.97P-944Q310.5R111.7
N27X38.328Y30.059Z245.813A-10.001B9.852U.171V.171W.97P-871.8Q485.2R68.2
N29X38.79Y30.911Z245.663A-10.001B9.852U.171V.171W.97P-766.1Q642.3R21.8
N31X39.412Y31.657Z245.532A-10.001B9.852U.171V.171W.97P-630.6Q775.7R-25.6
N33X40.169Y32.269Z245.424A-10.001B9.852U.171V.171W.97P-469.8Q879.8R-72.3
N35X41.034Y32.724Z245.343A-10.001B9.852U.171V.171W.97P-289.9Q949.9R-116.4
N37X41.972Y33.004Z245.294A-10.001B9.852U.171V.171W.97P-98Q982.9R-156
N39X42.947Y33.099Z245.277A-10.001B9.852U.171V.171W.97P0Q984.8R-173.6
N41G93F1.5X121.562Y33.572Z248.01A-10.001B4.928U.086V.173W.981P0Q984.8R-173.6

.../...

N89X30.911Y38.79Z245.663A-10.001B9.852U.171V.171W.97P642.3Q-766.1R21.8
N91X30.059Y38.328Z245.813A-10.001B9.852U.171V.171W.97P485.2Q-871.8R68.2
N93X29.136Y38.043Z245.976A-10.001B9.852U.171V.171W.97P310.5Q-944R111.7
N95X28.175Y37.947Z246.145A-10.001B9.852U.171V.171W.97P124.7Q-980.6R150.9
N97G40
N99F150X8.175
N101G0X9.886Y39.658Z255.848
N103X-33.061Y-3.289Z263.308A0B0
N105Z351
N107M2

2D Radial Tip

The tool tip will be visualized during tool path replay. Cutter compensation instructions are automatically generated in the 
NC data output. An approach macro must be defined to allow the compensation to be applied.
Example of generated APT source:

$$ Start generation of : Multi-Axis Flank Contouring.1
FEDRAT/ 1000.0000,MMPM
SPINDL/ 70.0000,RPM,CLW
CUTCOM/LEFT
$$ START CUTCOM PLANAR XT, YT, ZT, I, J, K
GOTO / 100.00000, -125.00000, 10.00000, 0.0000, 0.0000, 1.0000
GOTO / 0.00000, -125.00000, 10.00000, 0.0000, 0.0000, 1.0000
CUTCOM/OFF
$$ END CUTCOM PLANAR XT, YT, ZT, I, J, K
$$ End of generation of : Multi-Axis Flank Contouring.1

None

Cutter compensation instructions are not automatically generated in the NC data output. However, CUTCOM instructions can 
be inserted manually. For more information, please refer to How to generate CUTCOM syntaxes. 

Multi-Axis Flank Contouring: Geometry

You can specify the following Geometry:

●     Part with possible Offset on Part. 

●     Drives surfaces with possible Offset on Drive.

●     Start and Stop limiting elements with possible Offset on Start and Offset on Stop.
The tool can be positioned with respect to the start and Stop elements by selecting one of the proposed options: On, In, 
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Out, or Tangent to Drive. 

●     Fixture or check elements with possible Offset on Check.

●     Offset along Tool Axis.

Drive Elements 

Surfaces or planes can be selected and they are taken into account according to their order of selection. The tool path starts 
on the first drive and ends on the last drive, except when Close tool path is set (in this case, the first drive is also used as 
the last drive).

The program determines automatically the stopping and restarting conditions between contiguous drives. If drives are not 
adjacent, those values must be set manually with the local modifications capability. The program automatically detects fillets 
and joggles (features comprising 3 contiguous drives) to manage the choice of suitable elements for stopping.

Use Curves as Part

You can select edges that are boundaries of the drive elements as part elements. To do this, right click the part surface area 
in the sensitive icon and select the Use Curves as Part contextual command.

Start and Stop Elements

You can select vertices, edges, planes and faces as limiting elements. If a vertex or edge is selected, a virtual plane is 
computed on the vertex or at the middle of the edge perpendicular to the current drive and part.

Start Position and Optional Reference Point

A typical start element is a plane/almost planar surface that is normal to the drive, and normal to the part. This allows the 
program to use an automatic reference point.

It is recommended to select an edge or vertex that will automatically simulate a correct plane.

In the case of a manually selected reference point, you have to imagine that the tool makes a virtual move from a Reference 
position to the Start position, which is the end position of that move. The Reference position is defined by the reference point 
and the tool axis at that point.

The tool move moves from the Reference position to an intermediate position then on to the Start position when Part, Drive 
and Check surfaces are specified. 

The intermediate position is defined as being the normal projection of the Reference point on the Drive surface. 

Reference position is not taken into account for tool path computation of the machining operation. It is only a reference 
location that helps to specify the Start position related to the Part, Drive and potentially Check surfaces that are specified by 
the user.

Expected results are obtained by respecting a reference position close to this end location (but at a distance greater than the 



tool radius value).

Selecting the fillet of the joggle as starting element is not a good choice. Because the elements are always seen as infinite, 
the extension of this fillet is parallel to the first drive. If these two elements do not have a common boundary, select a 
starting element whose extensions are not parallel to the drive (drive also seen as infinite).

Local Drive Surface Conditions

Local Restarting direction: Auto / Left / Right / Forward. This is a relative direction, seen from a cutter point of view. 
You should set the value according to the direction of the cutter at the end of the previous motion.  In Auto mode, the 
program applies either Left, Right or Forward according to local geometry conditions. 

Local Stopping condition: Auto / To / On / Past / Tangent DS. You should set the value according to how you want the 
cutter to reach the next drive. In Auto mode, the program applies either To, Past or Tangent DS according to local geometry 
conditions.

Local Tool side on drive: Same as first / Swap / On. You should keep in mind that the reference side is the one set on 
the first drive as indicated by the displayed arrow.  

Stopping and Restarting conditions must be defined on non contiguous drives. 

User defined settings may lead to bad tool paths. So you should ensure the consistency of the chosen collection of drive 
surfaces. For example, a gap between the end of a motion and the beginning of the next motion would generate a simple 
straight-line path, which is generally not suitable. 

In order to machine some gaps, you may have to create extra geometry. A typical example is two drive elements that are 
tangent but not contiguous, lying on the same surface. 

Geometry and Tool

Keep in mind that a geometric element is always extended to infinity, vertically and horizontally.

The cutting length of the tool should not be too great compared to the height of the drives. This can lead to bad results or 
failure in corners.

For negative draft angles the top of the cutting part of the tool is taken into account to define the fanning areas, if necessary 
along the vertical extension of the drive.

It is preferable to specify the cutting length of the tool in the Useful cutting length parameter.

Geometry Recommendations

Do not set the Close tool path option if the first drive is not to be machined as the last drive also.

Do not use a manual reference point if its use is not clearly defined. Prefer an automatic reference point, using a 
plane/planar surface as start element, normal to the drive1 and normal to the part (select an edge or a vertex that will 
simulate this plane without geometry creation).

Use a cutter whose cutting length (Lc) is nearly the height of the drive elements (use the Useful cutting length parameter, do 
not modify the tool).

Always keep in mind that all geometrical elements are seen as infinite elements, extended in all directions: horizontal and 
vertical. Also drive elements are machined in the order of selection, one after another.

Select the OUT condition to end after a joggle, or use a plane/edge/vertex as end element.

Multi-Axis Flank Contouring: Tool

Recommended tools for Multi-Axis Flank Contouring are End Mills and Conical Mills.



Multi-Axis Flank Contouring: Feeds and Speeds

In the Feeds and Speeds tab page, you can specify feedrates for approach, retract, machining, and  finishing as well as a 
machining spindle speed.

Feedrates and spindle speed can be defined in linear or angular units.

A Spindle output checkbox is available for managing output of the SPINDL instruction in the generated NC data  file. If the 
checkbox is selected, the instruction is generated. Otherwise, it is not generated. 

Feeds and speeds of the operation can be updated automatically according to tooling data and the Rough or Finish quality of 
the operation. This is described in Update of Feeds and Speeds on Machining Operation.

Feedrate Reduction in Corners

You can reduce feedrates in corners encountered along the tool path depending on values given in the Feeds and Speeds tab 
page: reduction rate, maximum radius, minimum angle, and distances before and after the corner.

Feed reduction is applied to corners along the tool path whose radius is less than the Maximum radius value and whose arc 
angle is greater than the Minimum angle value. Corners can be angled or rounded.

For Multi-Axis Flank Contouring, feedrate reduction applies to inside corners for machining or finishing passes. It does not 
apply to macros or default linking and return motions.

If a cornering is defined with a radius of 5mm and the Feedrate reduction in corners is set with a smaller radius value, the 
feedrate will not be reduced.

Multi-Axis Flank Contouring: NC Macros

You can define transition paths in your machining operations by means of NC Macros. These transition paths are useful for 
providing approach, retract and linking motion in the tool path. 

An Approach macro is used to approach the operation start point.

A Retract macro is used to retract from the operation end point.

A Linking macro may be used in several cases, for example: 

●     to link two non consecutive paths

●     to access finish and spring passes.

A Return on Same Level macro is used in a multi-path operation to link two consecutive paths in a given level.
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A Return between Levels macro is used in a multi-level machining operation to go to the next level.

A Return to Finish Pass macro is used in a machining operation to go to the finish pass.

A Clearance macro can be used in a machining operation to avoid a fixture, for example.



Multi-Axis Helix Machining 
The information in this section will help you create and edit Multi-Axis Helix Machining operations in your manufacturing program.

Click the  icon, then select the geometry to be machined .  A number of collision checking parameters can be set on the Geometry tab 

page.

A number of strategy parameters  are available for defining:

●     machining criteria

●     radial stepover conditions

●     tool axis mode

●     cutter compensation.

Specify the tool to be used , feeds and speeds , and NC macros  as needed.

For more information about how to specify this type of operation please refer to:

●     Create a Multi-Axis Helix Machining Operation in Lead and Tilt Mode

●     Create a Multi-Axis Helix Machining Operation in Interpolation Mode

●     Collision-Free Multi-Axis Helix Machining.

Multi-Axis Helix Machining: Strategy Parameters

Multi-Axis Helix Machining: Machining Parameters
Direction of cut
Specifies how machining is to be done. 

●     In Climb milling, the front of the advancing tool (in the machining direction) cuts into the material first.

●     In Conventional, the rear of the advancing tool (in the machining direction) cuts into the material first.

Machining tolerance
Specifies the maximum allowed distance between the theoretical and computed tool path. 
Maximum discretization step
Defines the maximum allowed distance between two points on the tool path. It is used to ensure linearity between points that are far apart. 
Default value is 100 m.
Maximum discretization angle
Specifies the maximum angular change of tool axis between tool positions. It is used to add more tool positions (points and axis) if value is 
exceeded. Default value is 180 degrees.

 

Note: The Maximum discretization step and Maximum discretization angle influence the number of points on the tool path. The values 
should be chosen carefully if you want to avoid having a high concentration of points along the tool trajectory. 
These parameters also apply to macro paths that are defined in machining feedrate. They do not apply to macro paths that do not have 
machining feedrate (RAPID, Approach, Retract, User, and so on).

Multi-Axis Helix Machining: Radial Parameters



Stepover
Defines the criteria to be used for distributing the turns of the generated helix: by scallop height, distance between turns, or number of 
turns. 
Scallop height
Specifies the maximum scallop height between consecutive turns of the generated helix in the radial strategy. 
Distance between turns
Defines the maximum distance between consecutive turns of the generated helix in the radial strategy. 
Number of turns
Defines the number of turns of the generated helix in the radial strategy.
Skip path
Gives the possibility of not machining the path on the first contour, the path on the last contour, or both these paths.

Multi-Axis Helix Machining: Tool Axis Parameters
Tool axis mode
Specifies how the tool axis is to be guided: Lead and Tilt, 4-axis Tilt or Interpolation. 

Lead and Tilt

In this mode the tool axis is normal to the part surface with respect to a given lead angle (a) in the forward tool motion and with respect to 
a given tilt angle (B) in the perpendicular direction to this forward motion. 

There are several types of lead and tilt modes as follows:

●     Fixed lead and tilt: Here both the lead and tilt angles are constant.

●     Variable lead and fixed tilt: Here the tool axis is allowed to move from the specified lead angle within a specified range, the tilt angle 
remaining constant.

●     Fixed lead and variable tilt: Here the tool axis is allowed to move from the specified tilt angle within a specified range, the lead angle 
remaining constant.

Lead angle
Specifies a user-defined incline of the tool axis in a plane defined by the direction of motion and the normal to the part surface. The lead 
angle is with respect to the part surface normal. 

Maximum lead angle
Specifies a maximum lead angle. 

Minimum lead angle
Specifies a minimum lead angle. 

Tilt angle
Specifies a user-defined incline of the tool axis in a plane normal to the direction of motion. The tilt angle is with respect to the part surface 
normal. 

Allowed tilt
Specifies the range of allowed tilt variation. 

4-axis Tilt

The tool axis is normal to the part surface with respect to a given tilt angle and is constrained to a specified plane. This mode has the same 
behavior as Lead and Tilt except that the local normal to the part is replaced by a normal to plane constraint. You can specify a Lead Angle 
and a Tilt angle.



For example, this mode is dedicated to milling parts with tool axis nearly parallel to the part itself (near flank milling). It is primary intended 
for NC machines whose configuration is A+C, but it can be used on any other multi-axis machine. 

Interpolation

In this mode the tool axis is interpolated between selected axes. Four default interpolation axes are proposed initially. The orientation of 
these axes can be adjusted by the user. Additional axes can be inserted anywhere on the area to machine to ensure that the tool can be 
positioned at each point on the trajectory and that the trajectory is collision-free.

The orientation of an axis is adjusted by means of the following dialog box:

●     Manual. Choose one of the following: 
❍     Coordinates to define the orientation by means of X, Y and Z components. 

❍     Angles to define the orientation by means of a rotation of the X, Y or Z axis. The rotation is specified by means of one or two angles.

●     Selection. If you select a line or linear edge, the tool axis will have the same orientation as that element. If you select a planar 
element, the tool axis will be normal to that element. 

●     Points in the View.  Just select two points to define the orientation.

The tool axis is visualized by means of an arrow. The direction can be reversed by clicking Reverse Direction in the dialog box. 

You can also choose to display the tool by means of the checkbox. 

Just click OK to accept the specified tool axis orientation.

Multi-Axis Helix Machining: Cutter Compensation Parameters

In the Machine Editor, the Compensation tab contains options for: 
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●     globally defining the 3D contact cutter compensation mode: None/Contact/Tip and Contact

●     imposing the compensation mode to all operations supporting the selected mode whatever the choice defined at machining operation level.

If the options are set as follows, compensation can be managed at machining operation level.

In this case a Compensation tab appears in the Strategy page of the machining operation editor, and the following options are available.

Compensation output 
Allows you to manage the generation of Cutter compensation (CUTCOM) instructions in the NC data output:

The following options are proposed:

●     3D Contact (G29/CAT3Dxx)

●     None.

3D Contact (G29/CAT3Dxx)

The tool contact point will be visualized during tool path replay. Cutter compensation instructions are automatically generated in the NC 
data output. An approach macro must be defined to allow the compensation to be applied.
Example of generated APT source:

$$ Start generation of : Multi-Axis Helix Machining.1
FEDRAT/ 1000.0000,MMPM
SPINDL/ 70.0000,RPM,CLW
CUTCOM/NORMPS
$$ START CUTCOM NORMPS XC, YC, ZC, XN, YN, ZN, I, J, K
.../...
CUTCOM/OFF
$$ END CUTCOM NORMPS XC, YC, ZC, XN, YN, ZN, I, J, K
$$ End of generation of : Multi-Axis Helix Machining.1

None

Cutter compensation instructions are not automatically generated in the NC data output. However, CUTCOM instructions can be inserted 
manually. For more information, please refer to How to generate CUTCOM syntaxes.

Multi-Axis Helix Machining: Geometry

You can specify the following Geometry:

●     Part elements (faces) with possible Offset on Part. 
Faces must be continuous in tangency in order to ensure good quality tool paths.

●     Four limiting curves comprising:
❍     Upper and lower contours, which must be closed contours. The selected curves must lie on faces.

❍     Leading and trailing edges, which must intersect the upper and lower contours. The selected curves must lie on faces.

file:///E|/www/jmndocr14/Doc/online/pmgug_C2/pmgugmt0100.htm


●     A Start or a Stop point, which specifies the entry or the exit point of the helix. When one point is selected, the other point is automatically 
deduced.

●     Optionally, check elements with possible Offset on Check.

Multi-Axis Helix Machining: Collision Checking

This section shows how collision checking is managed in Multi-axis Helix Machining operations. The Collision Checking parameters are accessed in 
the Geometry tab page of the operation's dialog box.  

Collision checking can be performed on check and part elements with the tool assembly (that is, the complete shape of the cutter plus its holder) 
or the cutting part of the tool (red part of following tools): 

 

To save computation time, you should use the tool assembly only if the geometry to be checked can interfere with the upper part of the cutter.

Collisions with Check Elements 

The parameters involved for check elements (such as fixtures) are described below.

Check (or Fixture) accuracy
Defines the maximum error to be accepted with respect to the fixture with its offset. Setting this parameter to a correct value avoids spending 
too much computation time to achieve unnecessary precision.



Offset on check
Defines the minimum distance between the cutter and the fixture, used to limit the tool path. 

Allowed gouging 
Defines the maximum cutter interference with the fixture during "linking passes" (including approach and retract motion).

The illustration below shows return motion with no macro or jump.



The illustration below shows return motion with macro between path and fixture.

Collisions with Part Elements

To activate collision checking on part elements, you must select the Active checkbox. 

Part accuracy
Defines the maximum error to be accepted with respect to the part with its offset. This parameter is set to the machining tolerance value. It can 
be only be changed by modifying the machining tolerance.

Allowed gouging 
Defines the maximum cutter interference with the part during "linking passes" (including approach and retract motion).



In Multi-axis Helix Machining, collision checking with part elements is useful in the following case.

Concave and non smooth part milled with 0 degree Lead angle

Note that Allowed gouging must be set to a non zero value, otherwise a "Nothing to Mill" message may be issued.

In Multi-axis Helix Machining, collision checking on part elements is not useful in the following cases.

Convex part machined with ball, flat or filleted ended tool or with a Fixed or Variable tool axis mode.

 

 

Concave part milled with 0 degree Lead angle.

A "Nothing to Mill" message may be issued.



Multi-Axis Helix Machining: Tools

Recommended tools for Multi-Axis Helix Machining are End Mills, Face Mills, Conical Mills and T-Slotters.

Multi-Axis Helix Machining: Feeds and Speeds

In the Feeds and Speeds tab page, you can specify feedrates for approach, retract and machining as well as a machining spindle speed.

Feedrates and spindle speed can be defined in linear or angular units.

A Spindle output checkbox is available for managing output the SPINDL instruction in the generated NC data file. If the checkbox is selected, the 
instruction is generated. Otherwise, it is not generated. 

Feeds and speeds of the operation can be updated automatically according to tooling data and the Rough or Finish quality of the operation. This 
is described in Update of Feeds and Speeds on Machining Operation.

Multi-Axis Helix Machining: NC Macros

You can define transition paths in your machining operations by means of NC Macros. These transition paths are useful for providing approach, 
retract and linking motion in the tool path. 

An Approach macro is used to approach the operation start point.

A Retract macro is used to retract from the operation end point.

A Linking macro may be used in various cases (for example, to link two non consecutive paths).

A Clearance macro can be used in a machining operation to avoid a fixture, for example.
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Cavities Roughing
The information in this section will help you create and edit Cavities Roughing operations in your Manufacturing Program. 

In the  tab select the geometric components to be machined.

In the Strategy tab  you will find the machining strategy parameters.

Specify the tool to be used (only end mill tools  are available for this operation) and speeds and rates  .

You can also define transition paths in your machining operations by means of NC macros  as needed. These transition paths are useful 
to: 

●     optimize retract distances,

●     set the Approach and Retract parameters.

Only the geometry is required, all of the other parameters have a default value.

Cavities Roughing: Strategy parameters
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Sensitive icon

For Center(1) only:

Tool axis

Place the cursor on the upper vertical arrow and right-click to display the contextual menu.

The item Select opens a dialog box to select the tool axis:

 

You can choose between selection by Coordinates (X, Y, Z) or by Angles. Angles lets you choose the tool axis by rotation around a main axis. 
Angle 1 and Angle 2 are used to define the location of the tool axis around the main axis that you select.

●     Feature-defined: you select a 3D element such as a plane that will serve to automatically define the best tool axis.

●     Selection: you select a 2D element such as a line or a straight edge that will serve to define the tool axis.

●     Manual: you enter the coordinates of the tool axis.

●     Points in the view: click two points anywhere in the view to define the tool axis.

The Reverse Direction button lets you reverse the direction of the axis with respect to the coordinate system origin.

When available, you can also choose to display the tool and select the position of the tool (default or user-defined).

The item Analyze opens the Geometry Analyser.
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Machining direction

Available for the Back and forth tool path style.

Place the cursor on the lower horizontal arrow and right-click to display the contextual menu.

 

The item Select opens a dialog box to select the machining direction:

 

You can choose between selection by Coordinates (X, Y, Z) or by Angles. Angles lets you choose the machining direction by rotation around 
a main axis. Angle 1 and Angle 2 are used to define the location of the machining direction around the main axis that you select.

●     Selection: you select a 2D element such as a line or a straight edge that will serve to define the machining direction.

●     Manual: you enter the coordinates of the machining direction.

●     Points in the view: click two points anywhere in the view to define the machining direction.

The Reverse Direction button lets you reverse the direction of the axis with respect to the coordinate system origin.

 
 The item Optimize provides an automatic selection of the machining direction: the machining direction is defined by the shape of each pocket 

and set along the main direction of the pocket (X or Y).

 
The item Analyze opens the Geometry Analyser.
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Cavities Roughing: General Parameters

Center definition 

Used to define the thickness to leave on the sides and on the horizontal areas.  They are represented as follows on the icon.

Machine horizontal areas until minimum thickness

If you check this option, at least the minimum thickness defined above will be left on the horizontal areas.

 
 Tool path style 

Indicates the cutting style of the operation:

●     Concentric: the tool removes the most constant amount of material possible at each concentric pass. The tool is never directly in the heart 
of material. It also respects the given cutting mode in all cases. The approach mode with this style is always Helix. 
The associated parameters are Machining tolerance. Cutting mode, Machining mode.

●     Helical: the tool moves in successive concentric passes from the boundary of the area to machine towards the interior. The tool moves 
from one pass to the next by stepping over.
The associated parameters are Machining tolerance. Cutting mode, Machining mode, Helical movement, Always stay on bottom 
and Forced cutting mode on part contour.

●     Back and forth: this cutting style is made of two kinds of passes:
❍     back and forth passes,

❍     part contouring passes. The contouring passes can be applied before or after the back and forth passes. 

The associated parameters are Machining tolerance. Cutting mode, Machining mode, Contouring pass and Contouring pass ratio. 
You can choose to apply the High speed milling option to this tool path style. You can also define the machining direction.



Machining tolerance 

Maximum allowed distance between the theoretical and computed tool path. Consider the value to be the acceptable chord error.

 
Cutting mode 

Specifies the position of the tool regarding the surface to be machined. It can be: 

  
Climb or Conventional.

 The cutting mode (Climb/Conventional) is respected on the contouring tool passes generated by the Helical tool path style.





Machining mode 

 Defines the type of area to be machined:

●     By plane: the whole part is machined plane by plane, 

●     By area: the whole part is machined area by area, (not available for the Center(1) and Side(2) strategy.

then 

●     Pockets only: only pockets on the part are machined,

●     Outer part: only the outside of the part is machined,

●     Outer part and pockets: the whole part is machined outer area by outer area and then pocket by pocket.

See also Definition of Pockets and Outer part
 Contouring pass

Lets you decide whether the contouring passes are applied prior to or after the back and forth passes.

If the contouring passes are applied prior to the back and forth passes, the contouring passes can be computed on intermediate Z levels in 
order to reduce the tool loading. 

In that case:

●     an approach motion is done on each motion, 

●     the back and forth passes are organized to avoid full diameter milling,

●     you can define the Number of contours. 
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 Contouring pass ratio

This parameter is available when the tool path style is set to Back and Forth. It adjusts the position of the final pass for removing scallops. 
This is done by entering a percentage of the tool diameter (0 to 50).

Helical movement 

Specifies the way the tool moves in a pocket or an external zone. It can be: 

●     Inward: the tool starts from a point inside the zone and follows inward paths parallel to the boundary.

 

●     Outward: the tool starts from a point inside the zone and follows outward paths parallel to the boundary.

 

●     Both:  

●     for pockets, the tool starts from a point inside the pocket and follows outward paths parallel to the boundary.

●     for external zones, the tool starts from a point on the rough stock boundary and follows inward 
paths parallel to the boundary.

In Helical mode, the control of the Non Cutting Diameter (Dnc) has been enhanced, in particular in the computation of the ramping 
approaches. This improvement may cause a computation failure, resulting in this specific message: The tool core diameter is not 
compatible with some ramping motions.

  



Always stay on bottom 

This option becomes available when at least one tool path style is set to Helical. 

When machining a multi-domain pocket using a helical tool path style, this parameter forces the tool to remain in contact with the pocket 
bottom when moving from one domain to another. This avoids unnecessary linking transitions. 

Always stay on bottom is not active:

Always stay on bottom is active:

 



 Forced cutting mode on part contour

Only used with the helical tool path style. 

With part contouring switched on, the tool goes round the outside contour of the part before continuing. Deactivating this option allows you to 
gain machining time. The tool that you are using and the part you are working on must be such that contouring the rough stock is superfluous.

 

 

With part contouring switched on. Note how the tool went round the area 
to machine first: 

 

With part contouring switched off.  Note that the tool goes straight 
into helical mode: 

 

 

Cavities Roughing: Radial Parameters

Stepover

It can be defined by:

●     the Overlap ratio, i.e. the overlap between two passes, given as a percentage of the tool diameter 
(Tool diameter ratio),

●     the Overlap length between two passes,



●     the Stepover ratio, i.e. the stepover between two passes, given as a percentage of the tool diameter
(Tool diameter ratio),

●     the Stepover length between two passes given by the Max. distance between pass,

Cavities Roughing: Center Axial Parameters
 

 

Maximum cut depth 

Depth of the cut effected by the tool at each pass



Variable cut depths 

When the dialog box opens the distance between passes from the top to the bottom of the part is constant and is the same as the Maximum 
cut depth.

Change the Distance from top value and the Inter-pass value and then press Add to give a different depth value over a given distance.

In the example below the cut depth: 

●     from the top of the part to 15mm from the top is of 2 mm,

●     from 15mm from the top to 25mm from the top is 5mm,

●     and from 25 mm from the top to the bottom of the part is 10 mm.

Cavities Roughing: High Speed Milling Parameters

  
High speed milling activates and defines the parameters for High speed milling. 

Corner radius

Defines the radius of the rounded ends of passes when cutting with a Concentric tool path style and the radius of the rounded end of retracts 
with Helical and Concentric tool path styles. The ends are rounded to give a smoother path that is machined much faster.



This is what a tool path will look like if you do not use high speed milling parameters:

 

Here is the same tool path with the High speed milling switched on. Note how the round tool path ends. In both cases a concentric tool path 
style is used.

Similarly, here is what retracts look like without the high speed milling option: 

And here is the same tool path with high speed milling switched on:

 
●     With HSM and helical mode, the corner radius must be less than half the stepover distance. It will be forced to this value. 

●     The corner radius is not applied to the finish path.

 Corner radius on part contouring

Specifies the radius used for rounding the corners along the Part contouring pass of a HSM operation. This radius must be smaller than the 
value set for the Corner radius parameter

 

Cavities Roughing: Zone Parameters

 



 Pocket filter

Check this option to activate the filter for small passes. The non-cutting diameter of the tool can be entered in the Tool tab, pushing the More 
button. It is given as an information only in the Zone tab.

Not all pockets will be machined if there is not enough depth for the tool to plunge. A null value means that tool is allowed to plunge in 
pockets. The size of the smallest pocket is given below the data field.

 
However, the Smallest area to machine is taken into account only if the area detected has no impact on larger areas beneath. 

The Tool core diameter is taken into account:

●     in pockets (default operating mode),

●     also for outer parts when limiting contours are used.

When areas are filtered (i.e. not machined) with the Tool core diameter, the areas beneath those areas are not machined. 

 

Geometry



 

You can also specify the following geometry: 

●     Part with possible offset. 

●     Rough stock. If you do not have a rough stock you can create one automatically. You must define a rough stock if you have not already 
defined one in the Part Operation. See the Machining Infrastructure user's guide for further information.

●     Check element with possible offset. The check element is often a clamp that holds the part and therefore is not an area to be machined.

●     Safety plane. The safety plane is the plane that the tool will rise to at the end of the tool path in order to avoid collisions with the part. 
You can also define a new safety plane with the Offset option in the safety plane contextual menu. The new plane will be offset from the 
original by the distance that you enter in the dialog box along the normal to the safety plane. If the safety plane normal and the tool axis 
have opposed directions, the direction of the safety plane normal is inverted to ensure that the safety plane is not inside the part to 
machine.

 

 

●     Top plane which defines the highest plane that will be machined on the part,

●     Bottom plane which defines the lowest plane that will be machined on the part,

●     Imposed plane that the tool must obligatorily pass through. Use this option if the part that you are going to machine has a particular 
shape (a groove or a step) that you want to be sure will be cut.

 
 If you wish to use all of the planar surfaces in a part as imposed surfaces, use the Search/View ... option in the contextual menu to select 

them (the Part to  machine must be selected first). 
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When searching for planar surfaces, you can choose to find either: 

●     all of the planar surfaces in the part,

●     or only the planes that can be reached by the tool you are using. 

When you are using planar surfaces in a part as imposed surfaces and you are using an offset on the part, select Offset in the contextual menu 
and then enter an offset value that is the same as the offset on part value plus the machining tolerance value, e.g. if the offset on part is 1 mm 
and the machining tolerance is 0.1 mm, give  a value 1.1mm. 

This ensures that the imposed planar surface is respected  to within the offset and tolerance values.

 Using the two Imposed icons, you can define two sets of imposed planes, with eventually a different offset on each set.
 

●     Start point where the tool will start cutting. There are specific conditions for start points: 

●     They must be outside the machining limit. Examples of machining limits are the rough stock contour; a limit line, an offset on the 
rough stock, an offset on the limit line, etc.

●     They must not be positioned so as to cause collisions with either the part or the check element. If a start point for a given zone 
causes a collision, the tool will automatically adopt ramping approach mode.

●     The distance between the start point and the machining limit must be greater than the tool radius plus the machining tolerance. 
If the distance between the start point and the machining limit is greater than the tool radius plus the safety distance, the start 
point will only serve to define the engagement direction. 

●     If there are several start points for a given area, the one that is used is the first valid one (in the order in which they were 
selected) for that area. If there are several possible valid points, the nearest one is taken into account.

●     One start point may be valid and for more than one area.

●     If a limit line is used, the tool will approach outer areas of the part and pockets in ramping mode. towards the outside of the 
contour. The tool moves from the outside towards the inside of this type of area. In this case, you must define the start point.

  

If you use a limit line or if you use an inner offset on the rough stock, the start point may be defined inside the initial rough stock. The rules 
concerning the domain of the contour line or the offset on the rough stock contour line above must be applied.



 

●     Concentric tool path style: 
Start points are automatically defined. In this case, the start point is the center of the largest circle that can be described in the area to 
machine. Lateral approach modes cannot be used.

●     Helical Tool path styles: 
Whenever possible, the end of the engagement associated to the start point corresponds to the beginning of the sweeping path.

If this is no possible, the path will be cut to respect the constraint imposed by the start point. 



●     Inner points (only active if the Drilling mode has been selected in the Macro data tab). There are specific conditions for inner points: 

●     they are usable for pockets only,

●     They must not be positioned so as to cause collisions with either the part or the check element. If an inner point for a given 
pocket causes a collision, the tool will adopt a new inner point generated automatically.

●     the inner point must lay inside the pocket or inside the portion of the pocket that is machined.

●     If there are several inner points for a given pocket, the one that is used is the first valid one (in the order in which they were 
selected) for that pocket.

●     A point can not be valid for several pockets.

●     Limiting contour which defines the machining limit on the part, with the Side to machine parameter.

There is also the possibility of setting the order in which the zones on the part are machined.
 Please refer to the Selecting Geometric Components to learn how to select the geometry.

 
Minimum thickness to machine

Specifies the minimum material thickness that will be removed  when using overshoot or in a rework operation. 

 
In a given level, the thickness of material left can amount up to the value of the Minimum thickness to machine + twice the value of the 
tolerance. Therefore, on a level below you may have to mill a thickness amounting to the value of the  Minimum thickness to machine + twice 
the value of the tolerance of one or several levels above.

 Limit Definition  

Defines what area of the part will be machined with respect to the limiting contour(s). It can either be inside or outside. In the pictures below, 
there are three limiting contours on the rough stock. The yellow areas will be machined.
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Side to machine: Inside

Side to machine: Outside

 

 

●     If you are using a limiting contour, you should define the start point so as to avoid tool-material collision.

●     The use of limiting contours is totally safe is the limiting contour is fully contained by the roughing rough stock. Example of use: restricting 
the machining to a group of pockets. 

●     But we strongly advise against using a limiting contour that is partly outside the roughing or residual rough stock. Example: roughing 
rework or a first roughing with a complex rough stock). In that case, we recommend that you define a surface with holes or a mask to 
define the machining zone to work on. 

 

 

Stop position

Specifies where the tool stops: 

●     Outside stops the tool outside the limit line, 

●     Inside stops the tool inside the limit line, 

●     On stops the tool on the limit line.

Offset

Specifies the distance that the tool will be either inside or outside the limit line depending on the stop mode that you chose.

 
Force replay button is only used for reworking operations.  

Its purpose is to compute the residual rough stock remaining from operations preceding the current one, providing a rough stock has not been 
defined for this operation. Use it before pressing Replay.

 

Cavities Roughing: Macro data

For more information on how to save or load an existing macro, please refer to Build and use a macros catalog.
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Optimize retract 

This button optimizes tool retract movements. This means that when the tool moves over a surface where there are no obstructions, it will not 
rise as high as the safety plane because there is no danger of tool-part collisions. The result is a gain in time.

 

●     In some cases (where areas of the part are higher than the zone you are machining and when you are using a safety plane), the tool will 
cut into the part. When this happens, deactivate the Optimize retract button.

●     The axial safety distance should be larger than the axial cut depth of the last Cavities Roughing operation.

●     Parameter Optimize Retract is only available for the part to machine, not for the rough stock.

Axial safety distance

Maximum distance that the tool will rise to when moving from the end of one pass to the beginning of the next.

 
Mode

Specifies the engagement of the tool in the material:

●     Plunge; the tool plunges vertically,

●     Drilling; the tool plunges into previously drilled holes. You can change the Drilling tool diameter, Drilling tool angle and Drilling tool 
length,

●     Ramping; the tool moves progressively down at the Ramping angle,

●     Helix; the tool moves progressively down at the ramping angle with its center along a (vertical) circular helix of Helix diameter.

Those four approach modes apply to pockets.

●     If the Tool Path is Concentric, the approach is always Helix, either on outer areas or pockets.

●     Ramping approach mode applies to pockets but also outer areas in given conditions:  

●     If a limit line is used, the tool will approach outer areas of the part and pockets in ramping mode.

●     If a lateral approach is not possible (due to the check element), the approach is made in ramping mode.

Approach distance

Engagement distance for plunge mode.

Radial safety distance 

Distance that the tool moves horizontally before it begins its approach. 



Methodology
Methodology and conceptual information on the following topic is provided in this section.

Collision-Free Multi-Axis Helix Machining

Methodology and conceptual information on the following topics is provided in the NC Manufacturing 
Infrastructure User's Guide.

Machining Processes
Knowledgeware in Machining Processes

CATProduct and CATProcess Document Management
Design Changes and Associativity Mechanisms

Part Operation and Set Up Documents
Opposite Hand Machining

User Features for NC Manufacturing

Methodology and conceptual information on the following topics is provided in the Prismatic Machining 
User's Guide.

How to Generate CUTCOM Syntaxes
Select Hole Design Features for Machining   

Use Tolerances on Design Features for Machining.
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Collision-Free Multi-Axis Helix Machining
The following procedure explains how to produce a collision-free tool path when you use Multi-Axis Helix Machining in Interpolation mode. In 
this example, it describes an iterative process for machining a blisk blade while avoiding collisions with neighboring blades.

The stages of this procedure are:

●     Initial selections and settings

●     Selecting the interpolation axes and first replay

●     Collision checking with the part

●     Collision checking with the neighboring blades.

A user scenario of this procedure is provided in the section Create a Multi-Axis Helix Machining Operation in Interpolation Mode. More 
information about Multi-Axis Helix Machining is provided in the Reference section.

Initial Selections and Settings 

Geometry

In the Geometry tab of the machining operation editor, define the necessary geometry: 

●     Part elements: the front face, the back face, the leading face, and the trailing face.
The selected faces must be continuous in tangency in order to ensure good quality tool paths. 

●     Four limiting curves: upper closed contour, lower closed contour, leading edge, and trailing edge.
Selected curves must lie on faces.

●     Entry or exit point of the helix. 

However, at this stage do not select any check elements and make sure that the collision checking option is deactivated in the Part tab.

Tool

In the Tool  tab of the machining operation editor, select an appropriate tool for the geometry to be machined (for example, a conical ball-
ended mill tool).

Machining Parameters



In the Strategy tab of the machining operation editor, set the tool axis mode to Interpolation and set the other parameters (number of turns, 
and so on). 

Selecting the Interpolation Axes and First Replay

Four interpolation axes are proposed by default at the following intersection points:

●     between the upper contour and the leading edge

●     between the lower contour and the leading edge

●     between the upper contour and the trailing edge

●     between the lower contour and the trailing edge.

You can adjust the orientation of each of the default axes.

Replay the tool path to verify that the tool can be positioned at each point on the trajectory. If the tool cannot be positioned at each point on 
the trajectory, you may need to adjust the default axes and/or insert additional interpolation axes. You can insert any number additional axes 
on the faces of the blade.

Note that interpolation axes are applied at contact points on the trajectory. The application point of an interpolation axis must be on a 
selected face. If the point is not on a selected face, it will be projected onto the part. This may give undesirable results. Remember also that 
points created on the fly are not associative, so it is best to avoid creating points in this way.

You may need to adjust the orientation of the additional axes.

Replay the tool path to verify that the tool can be positioned at each point on the trajectory. 
The collision checking options are deactivated in the Geometry tab of the machining operation editor, so this replay is done with no collision 
check.

If the tool cannot be positioned at each point on the trajectory, adjust the interpolation axes until this criteria is satisfied.
If the tool can be positioned at each point on the trajectory, you can move onto the next stage: collision checking with the part. 

Collision Checking with the Part

Activate collision checking between the part and the tool assembly in the Geometry tab of the machining operation editor.



Replay the tool path to check for collisions. At this stage, since there are no selected check elements, collision checking is on the part 
elements only.

If there are collisions detected with the part, adjust the interpolation axes until the tool path is collision free.
If there are no collisions, you can move onto the next stage: collision checking with neighboring blades.

Collision Checking with the Neighboring Blades

In the Geometry tab of the machining operation editor select check elements as follows:

●     select the back face of the blade just in front of the blisk blade being machined

●     select the front face of the blade just behind the blisk blade being machined.

Replay the tool path to check for collisions. Now, the program checks for collisions between the tool assembly and the part and check 
elements.

If there are collisions detected, adjust the interpolation axes until the tool path is collision free.
If there are no collisions, you can save the Multi-Axis Helix Machining operation.

The lefthand figure below show an example of the default and additional interpolation axes necessary to obtain the collision-free trajectory 
illustrated in the righthand figure.

 



Glossary 

                   

A

approach 
macro

Motion defined for approaching the operation start point

auxiliary 
command

A control function such as tool change or machine table rotation. These commands may be 
interpreted by a specific post-processor.

axial 
machining 
operation

Operation in which machining is done along a single axis and is mainly intended for hole 
making (drilling, counter boring, and so on). 

B

back and forth Machining in which motion is done alternately in one direction then the other. 
Compare with one way.

blisk A one-piece bladed disk such as those used in aircraft engines or turbines.
bottom plane A planar geometric element that represents the bottom surface of an area to machine. It is 

normal to the tool axis.

C

clearance 
macro

Motion that involves retracting to a safety plane, a linear trajectory in that plane and then 
plunging from that plane. 

climb milling Milling in which the advancing tool rotates down into the material. Chips of cut material 
tend to be thrown behind the tool, which results to give good surface finish. 
Compare with conventional milling.

Combin 
Parelm

Tool axis guidance strategy for Multi-Axis Flank Contouring. This strategy combines three 
phases: 

●     tool fans over a given Leave distance

●     tool is tangent to the drive surface at a given Contact height and follows the surface 
isoparametrics

●     tool fans over a given Approach distance.

Combin Tanto Tool axis guidance strategy for Multi-Axis Flank Contouring. This strategy combines three 
phases: 

●     tool fans over a given Leave distance

●     tool is tangent to the drive surface at a given Contact height and is contained in a 
plane normal to forward direction

●     tool fans over a given Approach distance.

conventional 
milling

Milling in which the advancing tool rotates up into the material. Chips of cut material tend 
to be carried around with the tool, which often impairs good surface finish. 
Compare with climb milling.

D



DPM Digital Process for Manufacturing.

E

extension 
type

Defines the end type of a hole as being through hole or blind.

F

Facing 
operation

A surfacing operation in which material is removed in one cut or several axial cuts of equal 
depth according to a pre-defined machining strategy. Boundaries of the planar area to be 
machined are soft.

Fault Types of faults in material removal simulation are gouge, undercut, and tool clash.
feedrate Rate at which a cutter advances into a work piece. 

Measured in linear or angular units (mm/min or mm/rev, for example).
Fixed Tool axis guidance strategy for Multi-Axis Flank Contouring.  The tool axis is fixed.
fixture Elements used to secure or support the workpiece on a machine.

G

gouge Area where the tool has removed too much material from the workpiece.

H

hard A geometric element (such as a boundary or a bottom face) that the tool cannot pass 
beyond.

high speed 
milling (HSM)

Functionality that is available for operations such as Flank Contouring, Pocketing and 
Facing in which corners and transitions in the tool path are rounded to ensure a smooth 
and continuous cutting effort.

I

inward helical Machining in which motion starts from a point inside the domain to machine and follows 
paths parallel to the domain boundary towards the center of the domain. Compare with 
outward helical.

island Inner domain of a pocket that is to be avoided during machining. It has a closed hard 
boundary.

L

linking motion Motion that involves retracting to a safety plane, a linear trajectory in that plane and then 
plunging from that plane. 

M

machine 
rotation

An auxiliary command in the program that corresponds to a rotation of the machine table.

machining 
axis system

Reference axis system in which coordinates of points of the tool path are given.

machining 
feature

A feature instance representing a volume of material to be removed, a machining axis, 
tolerances, and other technological attributes. These features may be hole type or milling 
type.



machining 
operation

Contains all the necessary information for machining a part of the workpiece using a single 
tool.

machining 
tolerance

The maximum allowed difference between the theoretical and computed tool path.

manufacturing 
process 

Defines the sequence of part operations necessary for the complete manufacture of a part.

manufacturing 
program

Describes the processing order of the NC entities that are taken into account for tool path 
computation: machining operations, auxiliary commands and PP instructions.

manufacturing 
view

The set of machining features defined in the part operation.

Mixed Combin Tool axis guidance strategy for Multi-Axis Flank Contouring. Either Combin Parelm or 
Combin Tanto is applied depending on the drive surface geometry. Combin Tanto is applied 
for cylindrical and planar drives. Combin Parelm is applied for other drive surface 
geometry.

multi-level 
operation

Milling operation (such as Flank, Contouring, Pocketing or Profile Contouring) that is done 
in a series of axial cuts.

N

Normal to 
Part

Tool axis guidance strategy for Multi-Axis Flank Contouring. The tool axis remains normal 
to the Part Surface while the tool remains in contact with the drive surface.

O

offset Specifies a virtual displacement of a reference geometric element in an operation (such as 
the offset on the bottom plane of a pocket, for example).  Compare with thickness. 

one way Machining in which motion is always done in the same direction. Compare with zig zag or 
back and forth.

outward 
helical

Machining in which motion starts from a point inside the domain to machine and follows 
paths parallel to the domain boundary away from the center of the domain. 
Compare with inward helical.

P

part operation Links all the operations necessary for machining a part based on a unique part registration 
on a machine. The part operation links these operations with the associated fixture and set-
up entities.

pocket An area to be machined that is defined by an open or closed boundary and a bottom plane. 
The pocket definition may also include a top plane and one or more islands.

Pocketing 
operation

A machining operation in which material is removed from a pocket in one or several axial 
cuts of equal depth according to a pre-defined machining strategy. 
The tool path style is either Inward helical, Outward helical or Back and forth.

Point to Point 
operation

A milling operation in which the tool moves in straight line segments between user-defined 
points.

PP instruction Instructions that control certain functions that are auxiliary to the tool-part relationship. 
They may be interpreted by a specific post processor.

PPR Process Product Resources.
Profile 
Contouring 
operation

A milling operation in which the tool follows a guide curve and possibly other guide 
elements while respecting user-defined geometric limitations and machining strategy 
parameters. 

R

retract macro Motion defined for retracting from the operation end point



return macro Motion for linking between paths or between levels.  It  involves retracting to a safety 
plane, a linear trajectory in that plane and then plunging from that plane. 

S

safety plane A plane normal to the tool axis in which the tool tip can move or remain a clearance 
distance away from the workpiece, fixture or machine.

set up Describes how the part, stock and fixture are positioned on the machine.
soft A geometric element (such as a boundary or a bottom face) that the tool can pass beyond.
spindle speed The angular speed of the machine spindle. 

Measured in linear or angular units (m/min or rev/min, for example).
stock Workpiece prior to machining by the operations of a part operation.

T

Tanto Tool axis guidance strategy for Multi-Axis Flank Contouring. This mode can only be 
assigned locally to a drive and not globally to the operation. The tool is tangent to the 
drive surface at a given contact height, and the tool axis is contained in a plane normal to 
forward direction. 

Tanto Fan Tool axis guidance strategy for Multi-Axis Flank Contouring. The tool is tangent to the drive 
surface at a given contact height, and the tool axis is interpolated between the start and 
end positions. 

thickness Specifies a thickness of material. 
Compare with offset.

top plane A planar geometric element that represents the top surface of an area to machine. It is 
always normal to the associated tool's rotational axis.

tool axis Center line of the cutter.
tool change An auxiliary command in the program that corresponds to a change of tool.
tool clash Area where the tool collided with the workpiece during a rapid move.
tool path The path that the center of the tool tip follows during a machining operation.
total depth The total depth including breakthrough distance that is machined in a hole making 

operation.

U

undercut Area where the tool has left material behind on the workpiece.

Z

zig zag Machining in which motion is done alternately in one direction then the other.
Compare with one way.
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